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1 Overview

This document provides configuration and administration information for the integration between Primavera P6 Enterprise Project Portfolio Management (P6 EPPM) and Oracle Utilities Work and Asset Management (WAM).




	
•


	
Additional Resources











	
•


	
Prerequisites











	
•


	
Supported Business Processes











	
1.1


	
Additional Resources








The following additional resources are available:




	
Resource


	
Location





	
Oracle Utilities Work and Asset Management Integration to Primavera P6 Enterprise Project Portfolio Management Installation Guide


	
Same folder as this document, with the distribution for this product.





	
Oracle Utilities Work and Asset Management Integration to Primavera P6 Enterprise Project Portfolio Management Release Notes


	
Same folder as this document, with the distribution for this product.





	
Oracle Utilities Work and Asset Management Documentation for Release v1.9.1


	
Refer to Oracle Utilities Work and Asset Management documentation located on the Oracle Software Delivery Cloud or on the Oracle Technology Network.

https://edelivery.oracle.com/

http://www.oracle.com/technetwork/documentation





	
Primavera P6 Enterprise Project Portfolio Management Documentation for Release v8.2


	
Refer to the Primavera P6 Enterprise Project Portfolio Management documentation located on the Oracle Software Delivery Cloud.

https://edelivery.oracle.com/





	
Oracle Fusion Middleware Concepts and Technologies Guide for Oracle Application Integration Architecture Foundation Pack 11g Release 1 (11.1.1.6.0)


	
Available on the Oracle Technology Network:

http://docs.oracle.com/cd/E21764_01/doc.1111/e17363/toc.htm





	
Domain Value Maps - Refer to the chapters titled Working with Domain Value Maps and Using SOA Composer with Domain Value Maps in the Oracle® Fusion Middleware Developer's Guide for Oracle SOA Suite .


	
Available on the Oracle Technology Network:

http://docs.oracle.com





	
DB Adapter - Refer to the Oracle Fusion Middleware User's Guide for Technology Adapters for more information.


	
Available on the Oracle Technology Network:

http://docs.oracle.com






Note: The latest versions of these documents are available on the Oracle Technology Network at http://www.oracle.com/technetwork/index.html




	
1.2


	
Prerequisites








All participating applications namely the Primavera P6 Enterprise Project Portfolio Management, Oracle Utilities Work and Asset Management, and Oracle Service-Oriented Architecture (SOA) Suite must be installed, set up, and working properly.




	
1.3


	
About the Integration Product








This section provides general information about the functionality and processing of Oracle Utilities Work and Asset Management Integration to Primavera P6 Enterprise Project Portfolio Management. This integration is an AIA Direct Integration using the Service-Oriented Architecture (SOA) Suite and does not require the AIA Foundation Pack to be installed.

The purpose of this integration is to export projects from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management so that enhanced project planning and scheduling can be used.




	
1.3.1


	
About the Products








The following products are involved in the integration:




	
•


	
Primavera P6 Enterprise Project Portfolio Management











	
•


	
Oracle Utilities Work and Asset Management











	
1.3.1.1


	
 Primavera P6 Enterprise Project Portfolio Management








Primavera P6 Enterprise Project Portfolio Management is the leading Enterprise Project Portfolio Management (EPPM) solution for project-intensive industries. It offers best-in-class capabilities focused on mission critical Project Portfolio Management (PPM) requirements of industries.

Primavera P6 Enterprise Project Portfolio Management enables enterprise agility, team productivity, portfolio predictability, and overall project management efficiency. This results in reducing cost, minimizing risk, and delivering results to key stakeholders.

Primavera P6 Enterprise Project Portfolio Management provides comprehensive project scheduling and tracking management to the utilities business enterprise. Primavera P6 Enterprise Project Portfolio Management provides the ability to manage resources and timelines visually, through a feature-rich interface, and has a web services interface for integration to other products.




	
1.3.1.2


	
Oracle Utilities Work and Asset Management








Oracle Utilities Work and Asset Management efficiently manages asset lifecycles, streamlines maintenance operations, maximizes supply chain performance, enhances safety, and improves regulatory compliance.

Oracle Utilities Work and Asset Management is a utility-specific solution that allows utilities to improve work efficiency and infrastructure reliability, while reducing maintenance cost and capital requirements. Oracle Utilities Work and Asset Management captures the maintenance and failure history of assets in the enterprise and allows users to plan project work and estimate effort, resources, and materials.




	
1.4


	
Supported Business Processes








In this integration, Oracle Utilities Work and Asset Management initiates all the integration points. The use cases supported by this integration are as follows:




	
•


	
Ability to export a Oracle Utilities Work and Asset Management project to create a Primavera P6 Enterprise Project Portfolio Management project to enhance planning and scheduling.











	
•


	
Ability to update the Primavera P6 Enterprise Project Portfolio Management project based on Oracle Utilities Work and Asset Management project changes.











	
•


	
Ability to retrieve existing Primavera P6 Enterprise Project Portfolio Management project information back into Oracle Utilities Work and Asset Management for work execution and/or continued planning.











	
•


	
Ability to synchronize crafts and related craft rates from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management resources and resource rates.








The business processes are as follow:




	
•


	
Synchronize Craft and Rates Integration Point











	
•


	
Create Project Integration Point











	
•


	
Update Project Details Integration Point











	
•


	
Retrieve Project Details Integration Point








Note : All integration points are initiated by Oracle Utilities Work and Asset Management. A basic assumption in this integration model is that scheduling will be done in Primavera P6 Enterprise Project Portfolio Management and not in Oracle Utilities Work and Asset Management. This integration does not try to synchronize or resolve Oracle Utilities Work and Asset Management and Primavera P6 Enterprise Project Portfolio Management scheduling methodologies.

Business use case examples include:




	
•


	
Plan work in Oracle Utilities Work and Asset Management and export work package details with estimates to Primavera P6 Enterprise Project Portfolio Management for scheduling/tracking.











	
•


	
Plan work in Primavera P6 Enterprise Project Portfolio Management and import selected information into Oracle Utilities Work and Asset Management to aid work execution.











	
•


	
Assign and manipulate work percent complete, assignments, and work relationships in Primavera P6 Enterprise Project Portfolio Management and update Oracle Utilities Work and Asset Management with this information.











	
•


	
Assign and manipulate tasks, work percent complete, assignments, and relationships in Oracle Utilities Work and Asset Management and update Primavera P6 Enterprise Project Portfolio Management with this information.










The following diagram provides a visual representation of this processing:

 [image: ]

Integration Points

The following diagram provides a visual representation of mapping between the Oracle Utilities Work and Asset Management and Primavera P6 Enterprise Project Portfolio Management objects:

 [image: ]

Integration Mapping



As shown in the diagram, only two Work Breakdown Structures (WBS) can be defined in Oracle Utilities Work and Asset Management. This structure goes from Project > Subproject > Work Order. It is possible to insert more levels in Primavera P6 Enterprise Project Portfolio Management; however, since this is not supported in Oracle Utilities Work and Asset Management, it is recommended that users should refrain from building more complex structures in Primavera P6. Building complex structures results in inability to synchronize with the Oracle Utilities Work and Asset Management application.





2 Understanding the Integration Process

This section outlines the overall technical overview, business processes, and specific integration points handled by the integration.




	
•


	
Technical Overview











	
•


	
Integration Points











	
2.1


	
Technical Overview








This direct integration between Primavera P6 Enterprise Project Portfolio Management and Oracle Utilities Work and Asset Management uses web services to facilitate communication between the two applications. The technical processes include the following:




	
•


	
All end-to-end integration points are synchronous.











	
•


	
All integration points are Oracle Utilities Work and Asset Management initiated.











	
•


	
Oracle Utilities Work and Asset Management invokes web services in the integration layer and receives a response from the integration layer.











	
•


	
The integration layer is made up of Service-Oriented Architecture (SOA) composites deployed on the SOA Suite. These composites use Business Process Execution Language (BPEL) components.











	
•


	
The integration BPEL processes transforms the message from Oracle Utilities Work and Asset Management format to Primavera P6 Enterprise Project Portfolio Management format using XSL and Domain Value Maps (DVM).











	
•


	
The integration then invokes the Primavera P6 Enterprise Project Portfolio Management web service and gets response back which it transforms back into the Oracle Utilities Work and Asset Management format and sends the response to Oracle Utilities Work and Asset Management. The integration process offers six different extension points as listed below:











	
•


	
Custom Templates











	
•


	
Custom-Transformations











	
•


	
Custom-Transformations .











	
•


	
Extension Web Services











	
•


	
Pre-Transformation Extension Point :











	
•


	
Post-Transformation Extension Point :











	
•


	
P6 Enterprise Project Portfolio to Oracle Utilities Work and Asset Management to Primavera Transformations .











	
•


	
Custom-Transformations .











	
•


	
The BPEL process includes:











	
•


	
A web service interface which Oracle Utilities Work and Asset Management invokes.











	
•


	
A web service reference which the integration uses to invoke the Primavera P6 Enterprise Project Portfolio Management web service.











	
•


	
Transformation to convert message from source format to target format. DVM's are used for the transformation.











	
•


	
All error responses are sent back to Oracle Utilities Work and Asset Management.








The following diagram provides a graphical representation of this processing:

 [image: ]

Technical Diagram






	
2.2


	
Integration Points








The integration points include:




	
•


	
Synchronize Craft and Rates Integration Point











	
•


	
Create Project Integration Point











	
•


	
Update Project Details Integration Point











	
•


	
Retrieve Project Details Integration Point











	
2.2.1


	
Synchronize Craft and Rates Integration Point








Oracle Utilities Work and Asset Management sends Crafts and Craft Rates to the integration layer. The integration maps this information as follows:




	
Oracle Utilities Work and Asset Management


	
Primavera P6 Enterprise Project Portfolio Management





	
Craft


	
Resource





	
Craft Rate


	
Resource Rate






The integration layer transforms the request message from Oracle Utilities Work and Asset Management format to Primavera P6 Enterprise Project Portfolio Management format and calls the Primavera P6 Enterprise Project Portfolio Management resource service and resource rates web service.

The following diagram provides a graphical representation of this processing:

.[image: ]

Synchronize Craft and Rates






	
2.2.1.1


	
Business Processing








 The following steps are performed:




	
•


	
The Primavera P6 Enterprise Project Portfolio Management success or failure response is sent back to Oracle Utilities Work and Asset Management by the integration layer.











	
•


	
Oracle Utilities Work and Asset Management sends the Crafts and Rates information in form of XML messages. These messages are transformed by the integration layer, and then sent to Primavera P6 Enterprise Project Portfolio Management. Primavera P6 sends an acknowledgement to the integration so that it can be transformed and sent to Oracle Utilities Work and Asset Management.











	
2.2.1.2


	
Technical Details








This section provides details on the composites, synchronization mapping, the map table structure and the Primavera P6 Enterprise Project Portfolio Management services used for the Update Crafts and Rates Integration Point.

Composites for Craft and Rate Synchronization




	
Composite Name


	
Description





	
OUWAMP6UpdateCraftRatesEBF


	
Updates Craft and Rates enterprise business process composite








Synchronization




	
Table Name


	
Description





	
UGBU_CRAFT_RATE_RESOURCE_MAP


	
 The Craft Rate mapping table UGBU_CRAFT_RATE_RESOURCE_MAP is used to store Oracle Utilities Work and Asset Management Craft and Rate mapping to Primavera P6 Enterprise Project Portfolio Management Resource and Resource Rates service.








UGBU_CRAFT_RATE_RESOURCE_MAP Table Structure




	
Column Name


	
Datatype


	
Mapping


	
System





	
PLANT


	
Varchar 5


	
PLANT


	
WAM





	
CRAFT


	
Varchar 10


	
CRAFT


	
WAM





	
DESCRIPTION


	
Varchar 255


	
DESC


	
WAM





	
RATE


	
Varchar 20


	
RATE


	
WAM





	
EFFECTIVE_DATE


	
DATE


	
EFFECTIVE_DATE


	
WAM





	
RESOURCE_OBJ_ID


	
Varchar 20


	
ResourceObjectID


	
Primavera





	
RESOURCE_RATE_OBJ_ID


	
Varchar 20


	
ResourceRateObjectID


	
Primavera








Primavera P6 Enterprise Project Portfolio Management Services




	
Service Name


	
Operation Name


	
Description





	
Resource Service


	
CreateResources


	
Used to create Resources in Primavera P6 Enterprise Project Portfolio Management. The CreateResources operation also creates a default Resource Rate.





	
Resource Rate Service


	
UpdateResourceRates


	
Used to update the Resource Rate created in Primavera P6 Enterprise Project Portfolio Management





	
Resource Rate Service


	
ReadResourceRates


	
Used to read the Resource Rates existing in Primavera P6 Enterprise Project Portfolio Management






Note : The Update Craft and Rates Integration point only supports custom xsl. There are no pre and post extension points available for this integration point.




	
2.2.2


	
Create Project Integration Point








Oracle Utilities Work and Asset Management sends data for a project to Primavera P6 Enterprise Project Portfolio Management. The project from Oracle Utilities Work and Asset Management is created in Primavera P6 Enterprise Project Portfolio Management and acknowledgement is sent back to Oracle Utilities Work and Asset Management.

The following diagram provides a graphical representation of this processing:

.[image: ]

Create Project






	
2.2.2.1


	
Business Processing








The following steps are performed:




	
•


	
The Oracle Utilities Work and Asset Management project is exported and using the details from the Project/Subproject module.











	
•


	
Oracle Utilities Work and Asset Management sends the project details to the integration layer by invoking a web service in the integration layer











	
•


	
The SOA integration layer transforms this message from Oracle Utilities Work and Asset Management format to Primavera P6 Enterprise Project Portfolio Management format and calls the P rimavera Import service -> CreateNewProject web service operation.











	
•


	
Primavera P6 Enterprise Project Portfolio Management returns a project ID on successful creation of a project. The Project ID is populated in the Oracle Utilities Work and Asset Management Project/Subproject module in the Project Management view.











	
•


	
The integration layer uses this project ID and invokes the Retrieve Project Details Integration Point which in turn calls the Primavera Export service -> ExportProject web service operation. This operation returns all the project details along with Primavera P6 Enterprise Project Portfolio Management generated IDs back to the integration layer.











	
•


	
The integration layer transforms this message back to Oracle Utilities Work and Asset Management format and sends it to Oracle Utilities Work and Asset Management.











	
•


	
The Primavera P6 Enterprise Project Portfolio Management success or failure response is sent back to Oracle Utilities Work and Asset Management by the integration layer.











	
•


	
Oracle Utilities Work and Asset Management sends the create project information in the form of XML messages. These messages are transformed by the integration layer to node information, and then sent to Primavera P6 Enterprise Project Portfolio Management. Primavera P6 Enterprise Project Portfolio Management sends an acknowledgement to the integration, so that it can be transformed and sent to Oracle Utilities Work and Asset Management.











	
2.2.2.2


	
Technical Details








This section provides details on the composites and Primavera P6 Enterprise Project Portfolio Management services used for the Create Project Integration Point.

Composites




	
Composite Name


	
Description





	
OUWAMP6CreateProjectEBF


	
Creates project enterprise business process composite.






Primavera P6 Enterprise Project Portfolio Management Services




	
Service Name


	
Operation Name


	
Description





	
Import Service


	
CreateNewProject


	
Used to create a project in Primavera P6 Enterprise Project Portfolio Management.





	
Export Service


	
ExportProject


	
Used by the Retrieve Project Details Integration point which uses Primavera P6 Project ID to get project details.











	
2.2.3


	
Update Project Details Integration Point








Oracle Utilities Work and Asset Management sends data for an updated project to Primavera P6 Enterprise Project Portfolio Management. The updated project from Oracle Utilities Work and Asset Management is updated in Primavera P6 Enterprise Project Portfolio Management and acknowledgement is sent back to Oracle Utilities Work and Asset Management.

The following diagram provides a graphical representation of this processing:

 [image: ]

Update Project Details






	
2.2.3.1


	
Business Processing








The following steps are performed:




	
•


	
The Primavera P6 Enterprise Project Portfolio Management project should be updated based on the project details from Oracle Utilities Work and Asset Management.











	
•


	
The Oracle Utilities Work and Asset Management project uses the project details from Oracle Utilities Work and Asset Management Project/Subproject module.











	
•


	
Oracle Utilities Work and Asset Management sends the project details to the integration layer by invoking a web service in the integration layer.











	
•


	
The integration layer transforms this message from Oracle Utilities Work and Asset Management format to Primavera P6 Enterprise Project Portfolio Management format and calls the Primavera Import service -> UpdateExistingProject web service operation.











	
•


	
Primavera P6 Enterprise Project Portfolio Management returns success flag on successful/unsuccessful update of the project.











	
•


	
The integration layer uses the Primavera P6 project ID in the Oracle Utilities Work and Asset Management request and invokes the Retrieve Project Details Integration Point which in turn calls the Primavera Export service -> ExportProject web service operation. This operation returns all project details along with Primavera P6 generated IDs back to the integration layer











	
•


	
The integration layer transforms this message back to Oracle Utilities Work and Asset Management format and sends it to Oracle Utilities Work and Asset Management.











	
•


	
The Primavera P6 Enterprise Project Portfolio Management success or failure response is sent back to Oracle Utilities Work and Asset Management by the integration layer.











	
•


	
Oracle Utilities Work and Asset Management sends the update project information in the form of XML messages. These messages are transformed by the integration layer, and then sent to Primavera P6 Enterprise Project Portfolio Management. Primavera P6 sends an acknowledgement to the integration, so that it can be transformed and sent to Oracle Utilities Work and Asset Management











	
2.2.3.2


	
Technical Details








This section provides details on the composites and Primavera P6 Enterprise Project Portfolio Management services used for the Update Project integration point.

Composites




	
Composite Name


	
Description





	
OUWAMP6UpdateProjectEBF


	
Updates the project enterprise business process composite.






Primavera P6 Enterprise Project Portfolio Management Services




	
Service Name


	
Operation Name


	
Description





	
Import Service


	
UpdateExistingProject


	
Used to update an existing project in Primavera P6 Enterprise Project Portfolio Management.





	
Export Service


	
ExportProject


	
Used by the Retrieve Project Details Integration Point which uses the Primavera P6 project ID to get the project details.









	
2.2.4


	
Retrieve Project Details Integration Point








Oracle Utilities Work and Asset Management retrieves project details from Primavera P6 Enterprise Project Portfolio Management. Oracle Utilities Work and Asset Management passes the Project ID in Primavera P6 as input and gets back the project details as output.

The following diagram provides a graphical representation of this processing:

 [image: ]

Retrieve Project Details




	
2.2.4.1


	
Business Processing








The following steps are performed:




	
•


	
Primavera P6 Enterprise Project Portfolio Management project detail should be retrieved and existing project in Oracle Utilities Work and Asset Management should be updated.











	
•


	
Oracle Utilities Work and Asset Management sends request for project details by invoking a web service in the integration layer











	
•


	
The integration layer transforms this request message from Oracle Utilities Work and Asset Management format to the Primavera P6 Enterprise Project Portfolio Management format and calls the Primavera Export service -> ExportProject web service operation.











	
•


	
Primavera P6 Enterprise Project Portfolio Management success or failure response is sent back to Oracle Utilities Work and Asset Management by the integration layer











	
•


	
Oracle Utilities Work and Asset Management sends the retrieve project information in the form of XML messages. These messages are transformed by the integration layer and then sent to Primavera P6. Primavera sends back project details to the integration, so that it can be transformed and sent to Oracle Utilities Work and Asset Management.











	
2.2.4.2


	
Technical Details








This section provides details on the composites and Primavera P6 Enterprise Project Portfolio Management services used for the Retrieve Project Details Integration Point.

Composites




	
Composite Name


	
Description





	
OUWAMP6RetrieveProjectEBF


	
Retrieve project details enterprise business flow composite process






Primavera P6 Enterprise Project Portfolio Management Services




	
Service Name


	
Operation Name


	
Description





	
Export Service


	
ExportProject


	
Used by the Retrieve project details integration flow which uses the Primavera P6 Enterprise Project Portfolio Management project ID to get the project details












3 Configuring the Integration

This section provides details regarding the configuration settings required for the integration, and also discusses in detail the following:




	
•


	
Integration Configuration Checklist











	
•


	
Setting up Primavera P6 Enterprise Project Portfolio Management











	
•


	
Setting Up Oracle Utilities Work and Asset Management











	
•


	
Setting up the Process Integration











	
3.1


	
Integration Configuration Checklist








Configuration is required to implement the integration between Primavera P6 Enterprise Project Portfolio Management and Oracle Utilities Work and Asset Management. For complete details see the following sections:




	
•


	
Primavera P6 Enterprise Project Portfolio Management Configuration Checklist











	
•


	
Oracle Utilities Work and Asset Management Configuration Checklist











	
•


	
Integration Product Configuration Checklist








Note: Please refer to the product documentation for Oracle Utilities Work and Asset Management or for Primavera P6 Enterprise Project Portfolio Management for complete configuration information.




	
3.1.1


	
Primavera P6 Enterprise Project Portfolio Management Configuration Checklist








Configure the EPS, UDFs and security in Primavera P6 Enterprise Project Portfolio Management:




	
•


	
Configure Enterprise Project Structure (EPS)











	
•


	
Configure User-Defined Fields (UDFs) Labor Sequence Number is mandatory. Others are optional.











	
•


	
Configure Security













	
3.1.2


	
Oracle Utilities Work and Asset Management Configuration Checklist








Configure the necessary business rules, batch jobs, security functions and modules related to Oracle Utilities Work and Asset Management functionality:




	
•


	
Configure Business Rules











	
•


	
Configure the Integration Batch Job











	
•


	
Configure Responsibility Settings











	
•


	
Configure Required Fields











	
3.1.3


	
Integration Product Configuration Checklist








In the integration layer, you must configure the configuration properties file, system properties, and domain value maps.




	
•


	
Configure Configuration Properties - Updates ConfigurationProperties.xml file











	
•


	
Configure System Properties - Sets Module Configurations properties that are shared by multiple integration points and Service Configurations properties that are used by a specific BPEL process.











	
•


	
Configure Domain Value Maps - Sets Domain value maps (DVMs) to map codes and other static values across applications.













	
3.2


	
Setting up Primavera P6 Enterprise Project Portfolio Management








To set up Primavera P6 Enterprise Project Portfolio Management (EPPM) for the integration, configure the following:




	
•


	
Configure Enterprise Project Structure (EPS)











	
•


	
Configure User-Defined Fields (UDFs)











	
•


	
Configure Security








Configure Enterprise Project Structure (EPS)

Enterprise Project Structure (EPS) must be created in Primavera P6 Enterprise Project Portfolio Management. EPS is similar to Plant in Oracle Utilities Work and Asset Management in that it organizes the application into "work sites" or "areas". Projects are created for the EPS name sent from Oracle Utilities Work and Asset Management.

To Set Up EPS for the Integration




	
1.


	
Create a new EPS in Primavera P6 Enterprise Project Portfolio Management.








Multiple EPS can be used to create projects in Primavera P6 Enterprise Project Portfolio Management. Oracle Utilities Work and Asset Management sends the EPS name in the request which is transformed to EPS Object ID by using the WAMP6_EPS DVM.




	
2.


	
Add the EPS Name and EPS Object ID mapping in the WAMP6_EPS DVM.











	
3.2.1


	
Configure User-Defined Fields (UDFs)








Primavera P6 Enterprise Project Portfolio Management User Defined Fields (UDFs) are used to create fields that are not sent over to Oracle Utilities Work and Asset Management by the integration as part of the base package.

If needed, you can create UDFs in Primavera P6 Enterprise Project Portfolio Management and populate additional Oracle Utilities Work and Asset Management fields. For example, if on the project the Oracle Utilities Work and Asset Management record includes an CONTACT_NAME. This would not be sent to Primavera P6 Enterprise Project Portfolio Management as part of the base integration, however a UDF can be created in Primavera P6 Enterprise Project Portfolio Management called P6-WAM_RESOURCE to capture the field in the integration.

A UDF for Labor Sequence Number must be configured before the Project data can be sent from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management. The other UDFs mentioned below are suggested for base level fields that should be created at the onset of your implementation, but they are optional.

UDF Type - Labor Sequence Number (Required)

Oracle Utilities Work and Asset Management sends the labor sequence number in the Create and Update project request. The labor sequence number is stored in Primavera P6 Enterprise Project Portfolio Management as a UDF for Resource Assignment.

To Create a UDF Type for Resource Assignment




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as Administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Resources > Assignment UDF.











	
3.


	
Add the UDF Type title and Object ID in the ConfigurationProperties > Module Configuration section.











	
4.


	
Update the following Properties:











	
•


	
P6.ResourceAssignment











	
•


	
UDFType.Name











	
•


	
P6.ResourceAssignment.UDFType.ObjectID











	
5.


	
Update MDS to ensure that the updated ConfigurationProperties.xml is loaded.








UDF Type - Project

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the project level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the Project level, and the details must be associated with the Project user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_ProjectUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > Project UDF.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_ProjectUDF DVM.








UDF Type - Sub Project (WBS)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the sub project level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the WBS level and the details must be associated with the WBS user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_SubprojectUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > SubprojectUDF DVM.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_SubprojectUDF DVM.








UDF Type - Work Order (WBS)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the Work Order level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the WBS level, and the details must be associated with the WBS user defined attribute in Oracle Utilities Work and Asset Management using the  WAMP6_WorkOrderUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > WBS UDFs.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_WorkOrderUDF DVM.








UDF Type - Work Order Task (Activity)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the Work Order Task level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the Activity level, and the details must be associated with the Activity user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_WorkOrderTaskUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > WBS UDFs.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_WorkOrderUDF DVM.








Note : The Primavera P6 Enterprise Project Portfolio Management web services can be used to get the Object ID for a newly created object. Use the appropriate web service > Read operation to get the Object ID.




	
3.2.2


	
Configure Security








This integration supports Web Service Security with user name token and the security setup needs to be done in Primavera P6 Enterprise Project Portfolio Management.

To Configure Primavera P6 Enterprise Project Portfolio Management Security




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as Administrator.











	
2.


	
Navigate to Configurations > Custom > Primavera P6 Configuration > Web Services > Security to set the following field values:











	
•


	
Authentication > Mode = Username Token Profile











	
•


	
Authentication > UserName Token Profile > Nonce > Require Nonce = false











	
•


	
Authentication > UserName Token Profile > Created > Require Created = false











	
•


	
Message Protection > Require Timestamp = false











	
•


	
Message Protection > Require Digital Signatures for Incoming Messages = false











	
•


	
Message Protection > Require Encryption for Incoming Messages = false











	
•


	
Message Protection > Encrypt Response = false











	
3.3


	
Setting Up Oracle Utilities Work and Asset Management








The configuration tasks in Oracle Utilities Work and Asset Management include:




	
•


	
Configure Business Rules











	
•


	
Configure the Integration Batch Job











	
•


	
Configure Responsibility Settings











	
•


	
Configure Required Fields








The following sections provide a general overview of these steps:




	
3.3.1


	
Configure Business Rules








Configure the Oracle Utilities Work and Asset Management business rules as indicated below.




	
3.3.1.1


	
Project Management Business Rule








Configure the following rule keys:




	
•


	
DEFAULT SUBPROJECT TYPE - Stores the user-defined default for subproject type for any new subproject record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration.











	
•


	
DEFAULT WORK ORDER ACCOUNT - Stores the user-defined default for account number for any new work order record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration.











	
•


	
DEFAULT WORK ORDER TYPE - Stores the default for work order type for any new work order record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration. The default is "R" for regular work order type.











	
•


	
PRIMAVERA_P6 - Indicates whether the Primavera P6 Enterprise Project Portfolio Management integration is ON/OFF (Default option is ON). Also, it stores the user-defined URL to launch the Primavera P6 Enterprise Project Portfolio Management application. This URL can also be overridden on the User Profile record as well.











	
•


	
PRIMAVERA_P6_EPS_NAME - Stores the user-defined name of the Primavera P6 Enterprise Project Portfolio Management EPS. This establishes the default EPS name that is used at the project level on projects created in Oracle Utilities Work and Asset Management. EPS needs to be setup in Primavera P6 Enterprise Project Portfolio Management before the integration can function. If necessary, users can override this name in their own User Profile record. There is also an EPS DVM which manages the mapping between the EPS name entered here, and the Object ID used by the Primavera P6 Enterprise Project Portfolio Management web service.











	
•


	
PRIMAVERA_RESOURCES_SYNCH - Indicates whether to send updates of the CRAFT RATES business rule to Primavera P6 Enterprise Project Portfolio Management. The option is ON/OFF with the default option as OFF.











	
•


	
PRIMAVERA_WORK_STATUS_UPDATE - Indicates whether updates from Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management work order statuses are allowed. The option is ON/OFF with the default option as OFF.











	
3.3.1.2


	
Craft Rates Business Rule








The Craft Rates business rule is synchronized with Primavera P6 Enterprise Project Portfolio Management using the wifp_primavera_synch_resources batch job, so the rule does not need to be configured directly You can choose to update this rule manually using settings in the Project Management business rule via the PRIMAVERA_RESOURCES_SYNCH rule key (see above).




	
3.3.1.3


	
Web Services Gateway Business Rule








Configure the following rule keys:




	
•


	
PRIMAVERA CREATE PROJECT - This stores the setup information to the integration Service-Oriented Architecture (SOA) server for the Create Project service.











	
•


	
PRIMAVERA RETRIEVE PROJECT - This stores the setup information to the integration SOA server for the Retrieve Project service.











	
•


	
PRIMAVERA SYNCH RESOURCES - This stores the setup information to the integration SOA server for the Craft-Resources synch service.











	
•


	
PRIMAVERA UPDATE PROJECT - This stores the setup information to the integration SOA server for the Update Project service.











	
•


	
Enter a Log Level in the last column to have errors for the related setting written to an error log.








Note: Each rule key must have the Username, Password, Service URL, and GateWay URL.




	
3.3.2


	
Configure the Integration Batch Job








The batch job, wifp_primavera_synch_resouces sends values from the Craft Rates business rule to the integration.

Name: wifp_primavera_synch_resouces

Parameters:




	
•


	
Job Number (Example: 43)











	
•


	
Plant code (Example: 01)











	
•


	
"O" (only supports outbound interface) (Example: O)











	
•


	
"N" (parameter is a placeholder and not used) "(Example: N)











	
•


	
This parameter can be used to pass one CRAFT code to synchronize; otherwise, set to NULL (Example: null).











	
•


	
This parameter used to set custom Pre-processor PL/SQL procedure/package name, if any; otherwise set to NULL (Example: null).











	
•


	
This parameter used to set custom Post-processor PL/SQL procedure/package name, if any; otherwise set to NULL (Example: null).











	
3.3.3


	
Configure Responsibility Settings








Access to functionality is managed through the Responsibility module in Oracle Utilities Work and Asset Management. There are three security functions that must be assigned to a Responsibility (which is in turn assigned to a user) to give access to use this integration:




	
•


	
PROJECT MANAGEMENT - Allows access to the Project Management view on the Oracle Utilities Work and Asset Management Project.











	
•


	
PRIMAVERA EXPORT - Allows access to the action to export projects from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.











	
•


	
PRIMAVERA IMPORT - Allows access to the action to import projects from Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management.











	
3.3.4


	
Configure Required Fields








Primavera P6 Enterprise Project Portfolio Management Activity relationships require a relationship code. To ensure that this code is filled correctly by users, set these as required fields in the Oracle Utilities Work and Asset Management Work Order and Work Order Task modules.

To Set Required Fields in Oracle Utilities Work and Asset Management




	
1.


	
Open the Modules Administration module.











	
2.


	
Search for the Form Description " Work Order Task".











	
3.


	
Select Work Order in the Results of Search list.











	
4.


	
Select Required Fields from the Views list.











	
5.


	
Select the Block Names: TASK_PREDECESSOR and TASK_SUCCESSOR











	
6.


	
Set the RELATIONSHIP_CODE field " Required" with a suitable default value.











	
7.


	
Repeat this process for the Work Order module.











	
3.4


	
Setting up the Process Integration








The following sections describe how to configure integration pack to meet the requirements for a two-way integration.

Configuration steps include setting the following:




	
•


	
Configure Configuration Properties











	
•


	
Configure System Properties











	
•


	
Configure Domain Value Maps











	
3.4.1


	
Configure Configuration Properties








The ConfigurationProperties.XML file contains properties which can be defaulted in the integration. It also contains flags to enable extension points within the integration.

ConfigurationProperties.XML is located in MDS under the directory apps/P6-Oracle Utilities Work and Asset Management/AIAMetaData/config.

Note : Whenever the ConfigurationProperties.XML file is updated, it must be reloaded to the MDS repository so that update is reflected in applications or services which use these updated properties. Reload the SOA server by rebooting.




	
3.4.2


	
Configure System Properties








Two sets of configuration properties are described in this section:




	
•


	
Module Configuration are the properties shared by multiple integration points within this integration.











	
•


	
Service Configuration are the properties used by a specific BPEL process.











	
3.4.2.1


	
Module Configuration








Module Configuration has application level properties, which are used by all SOA composites.

Module Configuration Details




	
Module Name


	
Default / Shipped Value


	
Description





	
WAM.success.ErrorCode


	
0


	
Success code sent to Oracle Utilities Work and Asset Management from the integration layer.





	
WAM.success.ErrorDescription


	
SUCCESS


	
Success description sent to Oracle Utilities Work and Asset Management from the integration layer.





	
P6.Create.ImportOption


	
Keep Existing


	
Import option sent to Primavera P6 Enterprise Project Portfolio Management import service from the integration layer.





	
P6.ResourceAssignment.UDFType.Name


	
LaborSequenceNo


	
Assignment UDF Type defined in Primavera P6 Enterprise Project Portfolio Management to store the Labor sequence number. The UDF should be created before any data is sent across from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.





	
P6.ResourceAssignment.UDFType.ObjectID


	



	
Object ID generated and assigned by Primavera P6 Enterprise Project Portfolio Management to the Assignment UDF Type, which is defined in Primavera P6 Enterprise Project Portfolio Management to store the Labor sequence number. The UDFType Object ID must be set before any data is sent across from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.





	
P6.Project.Attachment.Size


	
1024


	
Used internally. Do not change this value.





	
P6.PercentComplete.Type


	
Physical


	
This property is sent to Primavera P6 Enterprise Project Portfolio Management to indicate the Percent Completion type being sent by Oracle Utilities Work and Asset Management. Currently Oracle Utilities Work and Asset Management only supports Physical percent complete. Primavera P6 Enterprise Project Portfolio Management supports Duration and Units percent complete, however this is not supported in the current integration.









	
3.4.2.2


	
Service Configuration








Service Configuration properties are specific to the SOA composites. These are used to make changes in a specific composite behavior.

Service Configuration Details




	
ServiceName


	
Property Name


	
Default Value


	
Description





	
OUWAMP6UpdateCraftRatesEBF





	



	
Prim.CraftsandRates.Technical.ErrorCode


	
1007


	
Error code send back to Oracle Utilities Work and Asset Management from integration layer for errors in the Update Craft and Rates EBS.





	



	
Prim.CraftsandRates.Technical.ErrorDescription


	
Technical Error from Primavera P6 Enterprise Project Portfolio Management


	
Error description sent back to Oracle Utilities Work and Asset Management from integration layer for errors in the Update Craft and Rates EBF. This can be modified by the implementation team.





	





	
Primavera.Resource.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ResourceService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management resource service. This can be modified by the implementation team.





	



	
Primavera.Resource.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/Resource/V1}ResourceService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management resource service.





	



	
Primavera.Resource.PortType


	
ResourcePortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management resource service.





	



	
Primavera.Rate.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ResourceRateService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management resource rate service. This can be modified by the implementation team.





	



	
Primavera.Rate.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/ResourceRate/V1}ResourceRateService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management resource rate service.





	



	
Primavera.Rate.PortType


	
ResourceRatePortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management resource rate service.





	
OUWAMP6CreateProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to the Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.CreateProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ImportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management import service. This can be modified by the implementation team.





	



	
P6.CreateProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSImport/V1}ImportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.CreateProj.PortType


	
ImportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.DefaultGlobalImportOption


	
Create New


	
Default global import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.DefaultProjectSpecificImportOption


	
Create New


	
Default project specific import iption for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.FileType


	
XML


	
File type format for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.IgnoreGUID


	
True


	
Ignore GUID option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.IgnoreSequenceNumber


	
True


	
Ignore sequence number option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.LogLevel


	
INFO


	
Log level option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.Create.ErrorCode


	
1001


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the import service 'Create Project operation fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Create.Retrieve.ErrorCode


	
1002


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the export service fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Create.Craft.ErrorCode


	
1006


	
Error code sent by integration to Oracle Utilities Work and Asset Management, if the integration layer is not able to find Crafts in the Integration Craft and Rates mapping table.





	



	
P6.Create.Craft.ErrorDescription


	
Plant Craft combination does not exist


	
The description for the property P6.Create.Craft.ErrorCode which has the error code. Implementation team can change this description.





	



	
P6.Create.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Update.Technical.ErrorDescription


	
Technical errorfrom middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.





	
OUWAMP6UpdateProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.UpdateProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ImportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management import service. This can be modified by the implementation team.





	



	
P6.UpdateProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSImport/V1}ImportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.UpdateProj.PortType


	
ImportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.DefaultGlobalImportOption


	
Update Existing


	
Default global import option





	



	
Prim.DefaultProjectSpecificImportOption


	
Update Existing


	
Default project specific import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.FileType


	
XML


	
File type format for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.IgnoreGUID


	
true


	
Ignore GUID option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.IgnoreSequenceNumber


	
true


	
Ignore sequence number option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.LogLevel


	
INFO


	
Log level option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.Update.ErrorCode


	
1003


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the import service 'Update Project operation fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Update.Retrieve.ErrorCode


	
1004


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the export service fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Update.Craft.ErrorCode


	
1006


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the integration layer is not able to find Crafts in the Integration Craft and Rates mapping table.





	



	
P6.Update.Craft.ErrorDescription


	
Plant Craft combination does not exist


	
The description for the property P6.Update.Craft.ErrorCode which has the error code. Implementation team can change this description.





	



	
P6.Update.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Update.Technical.ErrorDescription


	
Technical error from middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.





	



	
P6.Update.ImportOption


	
Keep Existing


	
Import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	
OUWAMP6RetrieveProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
false


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
false


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
false


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
false


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.RetrieveProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ExportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management export service. This can be modified by the implementation team.





	



	
P6.RetrieveProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSExport/V2}ExportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
P6.RetrieveProj.PortType


	
ExportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.Encoding


	
UTF-8


	
Encoding option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.LineSeparator


	
Unix


	
LineSeparator option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.SpreadPeriodType


	
Day


	
SpreadPeriodType option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.Spacing


	



	
Spacing option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.FileType


	
XML


	
FileType option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
P6.Retrieve.ErrorCode


	
1005


	
Error code sent by integration to Oracle Utilities Work and Asset Management for Primavera P6 Enterprise Project Portfolio Management Export service failure.





	



	
P6.Retrieve.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Retrieve.Technical.ErrorDescription


	
Technical error from middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.









	
3.4.3


	
Configure Domain Value Maps








Domain value maps (DVMs) are a standard feature of the Oracle SOA Suite. They map codes and other static values across applications.

For example: Different types of country codes configured in each of the applications can be mapped using a DVM. Country code for USA can be "US" in one application and map to "USA" in the other application.

DVMs are static in nature, though administrators can add additional maps as needed. Transactional business processes never update the Domain Value Maps (DVMs). Instead they only read from DVMs. They are stored in the XML files and cached in memory at runtime.

To Maintain Information within Domain Value Maps




	
1.


	
Open a browser and access the SOA Composer application ( http://host:port/soa/composer/)).











	
2.


	
On the SOA Composer, select Open from the drop-down list and select Open DVM.The list of all DVM files in the MDS repository is displayed.











	
3.


	
Select the relevant DVM you wish to maintain.











	
4.


	
Edit the selected DVM by clicking the Edit button in the top navigation bar for editing DVM.











	
5.


	
Once the DVM is edited, click Save in the navigation bar. This saves the DVM data for that session.











	
6.


	
Click Commit after updating each DVM.This saves the DVM data in the MDS repository.








The DVMs for the integration are described below. Each object refers to a valid object defined in Primavera P6 Enterprise Project Portfolio Management and a valid object defined in Oracle Utilities Work and Asset Management, as applicable:

Domain Value Code Details for the Integration Points




	
DVM


	
Integration Points


	
Description





	
WAMP6_EPS


	
Create Project and Retrieve Project Details


	
Maps the Primavera P6 Enterprise Project Portfolio Management EPS name stored in Oracle Utilities Work and Asset Management to the Primavera P6 Enterprise Project Portfolio Management EPS Object ID for that EPS in Primavera P6 Enterprise Project Portfolio Management and vice versa.





	
WAMP6_ProjectStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Project status to Primavera P6 Enterprise Project Portfolio Management Project status and vice versa.





	
WAMP6_ProjectUDF


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Project UDF Code to Primavera P6 Enterprise Project Portfolio Management Project UDF type Object ID and title.





	
WAMP6_SubprojectStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Sub Project status to Primavera P6 Enterprise Project Portfolio Management WBS status.





	
WAMP6_SubprojectUDF


	
WAMP6_SubprojectUDF


	
Maps the Oracle Utilities Work and Asset Management Sub Project UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type. object id and title





	
WAMP6_WorkOrderTaskStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order status to Primavera P6 Enterprise Project Portfolio Management. Management WBS status.





	
WAMP6_WorkOrderUDF


	
Create Project, Update Project., and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type.

 object id and title





	
WAMP6_WorkOrderTaskStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order Task status to Primavera P6 Enterprise Project Portfolio Management. Management Activity status.







	
WAMP6_WorkOrderTaskUDF


	
Create Project, Update Project, and Retrieve Project details.


	
Maps the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity. UDF type Object ID and title.







	
WAMP6_Relationship


	
Create Project, Update Project and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Relationship Code to Primavera P6 Enterprise Project Portfolio Management Relationship type. Object ID.









	
3.4.3.1


	
WAMP6_EPS








This DVM transforms a Primavera P6 Enterprise Project Portfolio Management EPS name stored in Oracle Utilities Work and Asset Management to a Primavera P6 Enterprise Project Portfolio Management EPS Object ID.




	
WAM_EPSName


	
P6_EPSObjectID





	
This is the Primavera P6 Enterprise Project Portfolio Management EPS Name stored in the Oracle Utilities Work and Asset Management Project Management business rule.


	
This is the EPS Object ID corresponding to the EPS name stored in Oracle Utilities Work and Asset Management.









	
3.4.3.2


	
WAMP6_ProjectStatus








This DVM transforms the Oracle Utilities Work and Asset Management Project Status to Primavera P6 Enterprise Project Portfolio Management Project Status and vice versa.




	
WAM_ProjectStatus


	
P6_ProjectStatus





	
This is project status in Oracle Utilities Work and Asset Management.


	
This is the project status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.3


	
WAMP6_ProjectUDF








This DVM transforms the Oracle Utilities Work and Asset Management Project UDF Code to Primavera P6 Enterprise Project Portfolio Management Project UDF type Object ID and title.




	
WAM_ProjectUDFCode


	
P6_ProjectUDFTypeTitle


	
P6_ProjectUDFTypeObjectID





	
This is the project level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the project level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the project level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.4


	
WAMP6_SubprojectStatus








This DVM transforms the Oracle Utilities Work and Asset Management Subproject status to Primavera P6 Enterprise Project Portfolio Management Work Breakdown Structure (WBS) status and vice versa.




	
WAM_SubprojectStatus


	
P6_WBSStatus





	
This is sub project status in Oracle Utilities Work and Asset Management.


	
This is the WBS status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.5


	
WAMP6_SubprojectUDF








This DVM transforms the Oracle Utilities Work and Asset Management Subproject UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type Object ID and title.




	
WAM_SubprojectUDFCode


	
P6_WBSUDFTypeTitle


	
P6_WBSUDFTypeObjectID





	
 This is the sub project level UDF attribute name in Oracle Utilities Work and Asset Management. For example, ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.6


	
WAMP6_WorkOrderStatus








This DVM transforms the Oracle Utilities Work and Asset Management Work Order status to Primavera P6 Enterprise Project Portfolio Management Work Breakdown Structure (WBS) status and vice versa.




	
WAM_WorkOrderStatus


	
P6_WBSStatus





	
This is work order status in Oracle Utilities Work and Asset Management.


	
This is the WBS status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.7


	
WAMP6_WorkOrderUDF








This DVM transforms the Oracle Utilities Work and Asset Management Work Order UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type Object ID and title.




	
WAM_WorkOrderUDFCode


	
P6_WBSUDFTypeTitle


	
P6_WBSUDFTypeObjectID





	
This is the work order level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.8


	
WAMP6_WorkOrderTaskStatus








This DVM transforms the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity UDF type Object ID and title.




	
WAM_WorkOrderTaskStatus


	
P6_ActivityStatus





	
This is work order task status in Oracle Utilities Work and Asset Management.


	
This is the Activity status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.9


	
WAMP6_WorkOrderTaskUDF








This DVM transforms the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity UDF type object ID and title.




	
WAM_WorkOrderTaskUDFCode


	
P6_ActivityUDFTypeTitle


	
P6_ActivityUDFTypeObjectID





	
This is the work order task level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the Activity level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the object ID of the Activity level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.10


	
WAMP6_Relationship








This DVM transforms the Oracle Utilities Work and Asset Management Relationship Code to a Primavera P6 Enterprise Project Portfolio Management Relationship type object ID.




	
WAM_RelationshipCode


	
P6_RelationshipType





	
This is relationship code in Oracle Utilities Work and Asset Management.


	
This is the relationship type in Primavera P6 Enterprise Project Portfolio Management.












3 Configuring the Integration

This section provides details regarding the configuration settings required for the integration, and also discusses in detail the following:




	
•


	
Integration Configuration Checklist











	
•


	
Setting up Primavera P6 Enterprise Project Portfolio Management











	
•


	
Setting Up Oracle Utilities Work and Asset Management











	
•


	
Setting up the Process Integration











	
3.1


	
Integration Configuration Checklist








Configuration is required to implement the integration between Primavera P6 Enterprise Project Portfolio Management and Oracle Utilities Work and Asset Management. For complete details see the following sections:




	
•


	
Primavera P6 Enterprise Project Portfolio Management Configuration Checklist











	
•


	
Oracle Utilities Work and Asset Management Configuration Checklist











	
•


	
Integration Product Configuration Checklist








Note: Please refer to the product documentation for Oracle Utilities Work and Asset Management or for Primavera P6 Enterprise Project Portfolio Management for complete configuration information.




	
3.1.1


	
Primavera P6 Enterprise Project Portfolio Management Configuration Checklist








Configure the EPS, UDFs and security in Primavera P6 Enterprise Project Portfolio Management:




	
•


	
Configure Enterprise Project Structure (EPS)











	
•


	
Configure User-Defined Fields (UDFs) Labor Sequence Number is mandatory. Others are optional.











	
•


	
Configure Security













	
3.1.2


	
Oracle Utilities Work and Asset Management Configuration Checklist








Configure the necessary business rules, batch jobs, security functions and modules related to Oracle Utilities Work and Asset Management functionality:




	
•


	
Configure Business Rules











	
•


	
Configure the Integration Batch Job











	
•


	
Configure Responsibility Settings











	
•


	
Configure Required Fields











	
3.1.3


	
Integration Product Configuration Checklist








In the integration layer, you must configure the configuration properties file, system properties, and domain value maps.




	
•


	
Configure Configuration Properties - Updates ConfigurationProperties.xml file











	
•


	
Configure System Properties - Sets Module Configurations properties that are shared by multiple integration points and Service Configurations properties that are used by a specific BPEL process.











	
•


	
Configure Domain Value Maps - Sets Domain value maps (DVMs) to map codes and other static values across applications.













	
3.2


	
Setting up Primavera P6 Enterprise Project Portfolio Management








To set up Primavera P6 Enterprise Project Portfolio Management (EPPM) for the integration, configure the following:




	
•


	
Configure Enterprise Project Structure (EPS)











	
•


	
Configure User-Defined Fields (UDFs)











	
•


	
Configure Security








Configure Enterprise Project Structure (EPS)

Enterprise Project Structure (EPS) must be created in Primavera P6 Enterprise Project Portfolio Management. EPS is similar to Plant in Oracle Utilities Work and Asset Management in that it organizes the application into "work sites" or "areas". Projects are created for the EPS name sent from Oracle Utilities Work and Asset Management.

To Set Up EPS for the Integration




	
1.


	
Create a new EPS in Primavera P6 Enterprise Project Portfolio Management.








Multiple EPS can be used to create projects in Primavera P6 Enterprise Project Portfolio Management. Oracle Utilities Work and Asset Management sends the EPS name in the request which is transformed to EPS Object ID by using the WAMP6_EPS DVM.




	
2.


	
Add the EPS Name and EPS Object ID mapping in the WAMP6_EPS DVM.











	
3.2.1


	
Configure User-Defined Fields (UDFs)








Primavera P6 Enterprise Project Portfolio Management User Defined Fields (UDFs) are used to create fields that are not sent over to Oracle Utilities Work and Asset Management by the integration as part of the base package.

If needed, you can create UDFs in Primavera P6 Enterprise Project Portfolio Management and populate additional Oracle Utilities Work and Asset Management fields. For example, if on the project the Oracle Utilities Work and Asset Management record includes an CONTACT_NAME. This would not be sent to Primavera P6 Enterprise Project Portfolio Management as part of the base integration, however a UDF can be created in Primavera P6 Enterprise Project Portfolio Management called P6-WAM_RESOURCE to capture the field in the integration.

A UDF for Labor Sequence Number must be configured before the Project data can be sent from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management. The other UDFs mentioned below are suggested for base level fields that should be created at the onset of your implementation, but they are optional.

UDF Type - Labor Sequence Number (Required)

Oracle Utilities Work and Asset Management sends the labor sequence number in the Create and Update project request. The labor sequence number is stored in Primavera P6 Enterprise Project Portfolio Management as a UDF for Resource Assignment.

To Create a UDF Type for Resource Assignment




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as Administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Resources > Assignment UDF.











	
3.


	
Add the UDF Type title and Object ID in the ConfigurationProperties > Module Configuration section.











	
4.


	
Update the following Properties:











	
•


	
P6.ResourceAssignment











	
•


	
UDFType.Name











	
•


	
P6.ResourceAssignment.UDFType.ObjectID











	
5.


	
Update MDS to ensure that the updated ConfigurationProperties.xml is loaded.








UDF Type - Project

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the project level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the Project level, and the details must be associated with the Project user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_ProjectUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > Project UDF.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_ProjectUDF DVM.








UDF Type - Sub Project (WBS)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the sub project level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the WBS level and the details must be associated with the WBS user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_SubprojectUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > SubprojectUDF DVM.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_SubprojectUDF DVM.








UDF Type - Work Order (WBS)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the Work Order level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the WBS level, and the details must be associated with the WBS user defined attribute in Oracle Utilities Work and Asset Management using the  WAMP6_WorkOrderUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > WBS UDFs.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_WorkOrderUDF DVM.








UDF Type - Work Order Task (Activity)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the Work Order Task level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the Activity level, and the details must be associated with the Activity user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_WorkOrderTaskUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > WBS UDFs.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_WorkOrderUDF DVM.








Note : The Primavera P6 Enterprise Project Portfolio Management web services can be used to get the Object ID for a newly created object. Use the appropriate web service > Read operation to get the Object ID.




	
3.2.2


	
Configure Security








This integration supports Web Service Security with user name token and the security setup needs to be done in Primavera P6 Enterprise Project Portfolio Management.

To Configure Primavera P6 Enterprise Project Portfolio Management Security




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as Administrator.











	
2.


	
Navigate to Configurations > Custom > Primavera P6 Configuration > Web Services > Security to set the following field values:











	
•


	
Authentication > Mode = Username Token Profile











	
•


	
Authentication > UserName Token Profile > Nonce > Require Nonce = false











	
•


	
Authentication > UserName Token Profile > Created > Require Created = false











	
•


	
Message Protection > Require Timestamp = false











	
•


	
Message Protection > Require Digital Signatures for Incoming Messages = false











	
•


	
Message Protection > Require Encryption for Incoming Messages = false











	
•


	
Message Protection > Encrypt Response = false











	
3.3


	
Setting Up Oracle Utilities Work and Asset Management








The configuration tasks in Oracle Utilities Work and Asset Management include:




	
•


	
Configure Business Rules











	
•


	
Configure the Integration Batch Job











	
•


	
Configure Responsibility Settings











	
•


	
Configure Required Fields








The following sections provide a general overview of these steps:




	
3.3.1


	
Configure Business Rules








Configure the Oracle Utilities Work and Asset Management business rules as indicated below.




	
3.3.1.1


	
Project Management Business Rule








Configure the following rule keys:




	
•


	
DEFAULT SUBPROJECT TYPE - Stores the user-defined default for subproject type for any new subproject record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration.











	
•


	
DEFAULT WORK ORDER ACCOUNT - Stores the user-defined default for account number for any new work order record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration.











	
•


	
DEFAULT WORK ORDER TYPE - Stores the default for work order type for any new work order record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration. The default is "R" for regular work order type.











	
•


	
PRIMAVERA_P6 - Indicates whether the Primavera P6 Enterprise Project Portfolio Management integration is ON/OFF (Default option is ON). Also, it stores the user-defined URL to launch the Primavera P6 Enterprise Project Portfolio Management application. This URL can also be overridden on the User Profile record as well.











	
•


	
PRIMAVERA_P6_EPS_NAME - Stores the user-defined name of the Primavera P6 Enterprise Project Portfolio Management EPS. This establishes the default EPS name that is used at the project level on projects created in Oracle Utilities Work and Asset Management. EPS needs to be setup in Primavera P6 Enterprise Project Portfolio Management before the integration can function. If necessary, users can override this name in their own User Profile record. There is also an EPS DVM which manages the mapping between the EPS name entered here, and the Object ID used by the Primavera P6 Enterprise Project Portfolio Management web service.











	
•


	
PRIMAVERA_RESOURCES_SYNCH - Indicates whether to send updates of the CRAFT RATES business rule to Primavera P6 Enterprise Project Portfolio Management. The option is ON/OFF with the default option as OFF.











	
•


	
PRIMAVERA_WORK_STATUS_UPDATE - Indicates whether updates from Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management work order statuses are allowed. The option is ON/OFF with the default option as OFF.











	
3.3.1.2


	
Craft Rates Business Rule








The Craft Rates business rule is synchronized with Primavera P6 Enterprise Project Portfolio Management using the wifp_primavera_synch_resources batch job, so the rule does not need to be configured directly You can choose to update this rule manually using settings in the Project Management business rule via the PRIMAVERA_RESOURCES_SYNCH rule key (see above).




	
3.3.1.3


	
Web Services Gateway Business Rule








Configure the following rule keys:




	
•


	
PRIMAVERA CREATE PROJECT - This stores the setup information to the integration Service-Oriented Architecture (SOA) server for the Create Project service.











	
•


	
PRIMAVERA RETRIEVE PROJECT - This stores the setup information to the integration SOA server for the Retrieve Project service.











	
•


	
PRIMAVERA SYNCH RESOURCES - This stores the setup information to the integration SOA server for the Craft-Resources synch service.











	
•


	
PRIMAVERA UPDATE PROJECT - This stores the setup information to the integration SOA server for the Update Project service.











	
•


	
Enter a Log Level in the last column to have errors for the related setting written to an error log.








Note: Each rule key must have the Username, Password, Service URL, and GateWay URL.




	
3.3.2


	
Configure the Integration Batch Job








The batch job, wifp_primavera_synch_resouces sends values from the Craft Rates business rule to the integration.

Name: wifp_primavera_synch_resouces

Parameters:




	
•


	
Job Number (Example: 43)











	
•


	
Plant code (Example: 01)











	
•


	
"O" (only supports outbound interface) (Example: O)











	
•


	
"N" (parameter is a placeholder and not used) "(Example: N)











	
•


	
This parameter can be used to pass one CRAFT code to synchronize; otherwise, set to NULL (Example: null).











	
•


	
This parameter used to set custom Pre-processor PL/SQL procedure/package name, if any; otherwise set to NULL (Example: null).











	
•


	
This parameter used to set custom Post-processor PL/SQL procedure/package name, if any; otherwise set to NULL (Example: null).











	
3.3.3


	
Configure Responsibility Settings








Access to functionality is managed through the Responsibility module in Oracle Utilities Work and Asset Management. There are three security functions that must be assigned to a Responsibility (which is in turn assigned to a user) to give access to use this integration:




	
•


	
PROJECT MANAGEMENT - Allows access to the Project Management view on the Oracle Utilities Work and Asset Management Project.











	
•


	
PRIMAVERA EXPORT - Allows access to the action to export projects from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.











	
•


	
PRIMAVERA IMPORT - Allows access to the action to import projects from Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management.











	
3.3.4


	
Configure Required Fields








Primavera P6 Enterprise Project Portfolio Management Activity relationships require a relationship code. To ensure that this code is filled correctly by users, set these as required fields in the Oracle Utilities Work and Asset Management Work Order and Work Order Task modules.

To Set Required Fields in Oracle Utilities Work and Asset Management




	
1.


	
Open the Modules Administration module.











	
2.


	
Search for the Form Description " Work Order Task".











	
3.


	
Select Work Order in the Results of Search list.











	
4.


	
Select Required Fields from the Views list.











	
5.


	
Select the Block Names: TASK_PREDECESSOR and TASK_SUCCESSOR











	
6.


	
Set the RELATIONSHIP_CODE field " Required" with a suitable default value.











	
7.


	
Repeat this process for the Work Order module.











	
3.4


	
Setting up the Process Integration








The following sections describe how to configure integration pack to meet the requirements for a two-way integration.

Configuration steps include setting the following:




	
•


	
Configure Configuration Properties











	
•


	
Configure System Properties











	
•


	
Configure Domain Value Maps











	
3.4.1


	
Configure Configuration Properties








The ConfigurationProperties.XML file contains properties which can be defaulted in the integration. It also contains flags to enable extension points within the integration.

ConfigurationProperties.XML is located in MDS under the directory apps/P6-Oracle Utilities Work and Asset Management/AIAMetaData/config.

Note : Whenever the ConfigurationProperties.XML file is updated, it must be reloaded to the MDS repository so that update is reflected in applications or services which use these updated properties. Reload the SOA server by rebooting.




	
3.4.2


	
Configure System Properties








Two sets of configuration properties are described in this section:




	
•


	
Module Configuration are the properties shared by multiple integration points within this integration.











	
•


	
Service Configuration are the properties used by a specific BPEL process.











	
3.4.2.1


	
Module Configuration








Module Configuration has application level properties, which are used by all SOA composites.

Module Configuration Details




	
Module Name


	
Default / Shipped Value


	
Description





	
WAM.success.ErrorCode


	
0


	
Success code sent to Oracle Utilities Work and Asset Management from the integration layer.





	
WAM.success.ErrorDescription


	
SUCCESS


	
Success description sent to Oracle Utilities Work and Asset Management from the integration layer.





	
P6.Create.ImportOption


	
Keep Existing


	
Import option sent to Primavera P6 Enterprise Project Portfolio Management import service from the integration layer.





	
P6.ResourceAssignment.UDFType.Name


	
LaborSequenceNo


	
Assignment UDF Type defined in Primavera P6 Enterprise Project Portfolio Management to store the Labor sequence number. The UDF should be created before any data is sent across from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.





	
P6.ResourceAssignment.UDFType.ObjectID


	



	
Object ID generated and assigned by Primavera P6 Enterprise Project Portfolio Management to the Assignment UDF Type, which is defined in Primavera P6 Enterprise Project Portfolio Management to store the Labor sequence number. The UDFType Object ID must be set before any data is sent across from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.





	
P6.Project.Attachment.Size


	
1024


	
Used internally. Do not change this value.





	
P6.PercentComplete.Type


	
Physical


	
This property is sent to Primavera P6 Enterprise Project Portfolio Management to indicate the Percent Completion type being sent by Oracle Utilities Work and Asset Management. Currently Oracle Utilities Work and Asset Management only supports Physical percent complete. Primavera P6 Enterprise Project Portfolio Management supports Duration and Units percent complete, however this is not supported in the current integration.









	
3.4.2.2


	
Service Configuration








Service Configuration properties are specific to the SOA composites. These are used to make changes in a specific composite behavior.

Service Configuration Details




	
ServiceName


	
Property Name


	
Default Value


	
Description





	
OUWAMP6UpdateCraftRatesEBF





	



	
Prim.CraftsandRates.Technical.ErrorCode


	
1007


	
Error code send back to Oracle Utilities Work and Asset Management from integration layer for errors in the Update Craft and Rates EBS.





	



	
Prim.CraftsandRates.Technical.ErrorDescription


	
Technical Error from Primavera P6 Enterprise Project Portfolio Management


	
Error description sent back to Oracle Utilities Work and Asset Management from integration layer for errors in the Update Craft and Rates EBF. This can be modified by the implementation team.





	





	
Primavera.Resource.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ResourceService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management resource service. This can be modified by the implementation team.





	



	
Primavera.Resource.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/Resource/V1}ResourceService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management resource service.





	



	
Primavera.Resource.PortType


	
ResourcePortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management resource service.





	



	
Primavera.Rate.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ResourceRateService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management resource rate service. This can be modified by the implementation team.





	



	
Primavera.Rate.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/ResourceRate/V1}ResourceRateService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management resource rate service.





	



	
Primavera.Rate.PortType


	
ResourceRatePortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management resource rate service.





	
OUWAMP6CreateProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to the Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.CreateProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ImportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management import service. This can be modified by the implementation team.





	



	
P6.CreateProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSImport/V1}ImportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.CreateProj.PortType


	
ImportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.DefaultGlobalImportOption


	
Create New


	
Default global import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.DefaultProjectSpecificImportOption


	
Create New


	
Default project specific import iption for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.FileType


	
XML


	
File type format for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.IgnoreGUID


	
True


	
Ignore GUID option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.IgnoreSequenceNumber


	
True


	
Ignore sequence number option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.LogLevel


	
INFO


	
Log level option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.Create.ErrorCode


	
1001


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the import service 'Create Project operation fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Create.Retrieve.ErrorCode


	
1002


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the export service fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Create.Craft.ErrorCode


	
1006


	
Error code sent by integration to Oracle Utilities Work and Asset Management, if the integration layer is not able to find Crafts in the Integration Craft and Rates mapping table.





	



	
P6.Create.Craft.ErrorDescription


	
Plant Craft combination does not exist


	
The description for the property P6.Create.Craft.ErrorCode which has the error code. Implementation team can change this description.





	



	
P6.Create.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Update.Technical.ErrorDescription


	
Technical errorfrom middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.





	
OUWAMP6UpdateProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.UpdateProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ImportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management import service. This can be modified by the implementation team.





	



	
P6.UpdateProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSImport/V1}ImportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.UpdateProj.PortType


	
ImportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.DefaultGlobalImportOption


	
Update Existing


	
Default global import option





	



	
Prim.DefaultProjectSpecificImportOption


	
Update Existing


	
Default project specific import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.FileType


	
XML


	
File type format for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.IgnoreGUID


	
true


	
Ignore GUID option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.IgnoreSequenceNumber


	
true


	
Ignore sequence number option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.LogLevel


	
INFO


	
Log level option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.Update.ErrorCode


	
1003


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the import service 'Update Project operation fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Update.Retrieve.ErrorCode


	
1004


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the export service fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Update.Craft.ErrorCode


	
1006


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the integration layer is not able to find Crafts in the Integration Craft and Rates mapping table.





	



	
P6.Update.Craft.ErrorDescription


	
Plant Craft combination does not exist


	
The description for the property P6.Update.Craft.ErrorCode which has the error code. Implementation team can change this description.





	



	
P6.Update.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Update.Technical.ErrorDescription


	
Technical error from middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.





	



	
P6.Update.ImportOption


	
Keep Existing


	
Import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	
OUWAMP6RetrieveProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
false


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
false


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
false


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
false


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.RetrieveProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ExportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management export service. This can be modified by the implementation team.





	



	
P6.RetrieveProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSExport/V2}ExportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
P6.RetrieveProj.PortType


	
ExportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.Encoding


	
UTF-8


	
Encoding option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.LineSeparator


	
Unix


	
LineSeparator option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.SpreadPeriodType


	
Day


	
SpreadPeriodType option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.Spacing


	



	
Spacing option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.FileType


	
XML


	
FileType option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
P6.Retrieve.ErrorCode


	
1005


	
Error code sent by integration to Oracle Utilities Work and Asset Management for Primavera P6 Enterprise Project Portfolio Management Export service failure.





	



	
P6.Retrieve.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Retrieve.Technical.ErrorDescription


	
Technical error from middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.









	
3.4.3


	
Configure Domain Value Maps








Domain value maps (DVMs) are a standard feature of the Oracle SOA Suite. They map codes and other static values across applications.

For example: Different types of country codes configured in each of the applications can be mapped using a DVM. Country code for USA can be "US" in one application and map to "USA" in the other application.

DVMs are static in nature, though administrators can add additional maps as needed. Transactional business processes never update the Domain Value Maps (DVMs). Instead they only read from DVMs. They are stored in the XML files and cached in memory at runtime.

To Maintain Information within Domain Value Maps




	
1.


	
Open a browser and access the SOA Composer application ( http://host:port/soa/composer/)).











	
2.


	
On the SOA Composer, select Open from the drop-down list and select Open DVM.The list of all DVM files in the MDS repository is displayed.











	
3.


	
Select the relevant DVM you wish to maintain.











	
4.


	
Edit the selected DVM by clicking the Edit button in the top navigation bar for editing DVM.











	
5.


	
Once the DVM is edited, click Save in the navigation bar. This saves the DVM data for that session.











	
6.


	
Click Commit after updating each DVM.This saves the DVM data in the MDS repository.








The DVMs for the integration are described below. Each object refers to a valid object defined in Primavera P6 Enterprise Project Portfolio Management and a valid object defined in Oracle Utilities Work and Asset Management, as applicable:

Domain Value Code Details for the Integration Points




	
DVM


	
Integration Points


	
Description





	
WAMP6_EPS


	
Create Project and Retrieve Project Details


	
Maps the Primavera P6 Enterprise Project Portfolio Management EPS name stored in Oracle Utilities Work and Asset Management to the Primavera P6 Enterprise Project Portfolio Management EPS Object ID for that EPS in Primavera P6 Enterprise Project Portfolio Management and vice versa.





	
WAMP6_ProjectStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Project status to Primavera P6 Enterprise Project Portfolio Management Project status and vice versa.





	
WAMP6_ProjectUDF


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Project UDF Code to Primavera P6 Enterprise Project Portfolio Management Project UDF type Object ID and title.





	
WAMP6_SubprojectStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Sub Project status to Primavera P6 Enterprise Project Portfolio Management WBS status.





	
WAMP6_SubprojectUDF


	
WAMP6_SubprojectUDF


	
Maps the Oracle Utilities Work and Asset Management Sub Project UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type. object id and title





	
WAMP6_WorkOrderTaskStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order status to Primavera P6 Enterprise Project Portfolio Management. Management WBS status.





	
WAMP6_WorkOrderUDF


	
Create Project, Update Project., and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type.

 object id and title





	
WAMP6_WorkOrderTaskStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order Task status to Primavera P6 Enterprise Project Portfolio Management. Management Activity status.







	
WAMP6_WorkOrderTaskUDF


	
Create Project, Update Project, and Retrieve Project details.


	
Maps the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity. UDF type Object ID and title.







	
WAMP6_Relationship


	
Create Project, Update Project and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Relationship Code to Primavera P6 Enterprise Project Portfolio Management Relationship type. Object ID.









	
3.4.3.1


	
WAMP6_EPS








This DVM transforms a Primavera P6 Enterprise Project Portfolio Management EPS name stored in Oracle Utilities Work and Asset Management to a Primavera P6 Enterprise Project Portfolio Management EPS Object ID.




	
WAM_EPSName


	
P6_EPSObjectID





	
This is the Primavera P6 Enterprise Project Portfolio Management EPS Name stored in the Oracle Utilities Work and Asset Management Project Management business rule.


	
This is the EPS Object ID corresponding to the EPS name stored in Oracle Utilities Work and Asset Management.









	
3.4.3.2


	
WAMP6_ProjectStatus








This DVM transforms the Oracle Utilities Work and Asset Management Project Status to Primavera P6 Enterprise Project Portfolio Management Project Status and vice versa.




	
WAM_ProjectStatus


	
P6_ProjectStatus





	
This is project status in Oracle Utilities Work and Asset Management.


	
This is the project status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.3


	
WAMP6_ProjectUDF








This DVM transforms the Oracle Utilities Work and Asset Management Project UDF Code to Primavera P6 Enterprise Project Portfolio Management Project UDF type Object ID and title.




	
WAM_ProjectUDFCode


	
P6_ProjectUDFTypeTitle


	
P6_ProjectUDFTypeObjectID





	
This is the project level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the project level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the project level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.4


	
WAMP6_SubprojectStatus








This DVM transforms the Oracle Utilities Work and Asset Management Subproject status to Primavera P6 Enterprise Project Portfolio Management Work Breakdown Structure (WBS) status and vice versa.




	
WAM_SubprojectStatus


	
P6_WBSStatus





	
This is sub project status in Oracle Utilities Work and Asset Management.


	
This is the WBS status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.5


	
WAMP6_SubprojectUDF








This DVM transforms the Oracle Utilities Work and Asset Management Subproject UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type Object ID and title.




	
WAM_SubprojectUDFCode


	
P6_WBSUDFTypeTitle


	
P6_WBSUDFTypeObjectID





	
 This is the sub project level UDF attribute name in Oracle Utilities Work and Asset Management. For example, ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.6


	
WAMP6_WorkOrderStatus








This DVM transforms the Oracle Utilities Work and Asset Management Work Order status to Primavera P6 Enterprise Project Portfolio Management Work Breakdown Structure (WBS) status and vice versa.




	
WAM_WorkOrderStatus


	
P6_WBSStatus





	
This is work order status in Oracle Utilities Work and Asset Management.


	
This is the WBS status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.7


	
WAMP6_WorkOrderUDF








This DVM transforms the Oracle Utilities Work and Asset Management Work Order UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type Object ID and title.




	
WAM_WorkOrderUDFCode


	
P6_WBSUDFTypeTitle


	
P6_WBSUDFTypeObjectID





	
This is the work order level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.8


	
WAMP6_WorkOrderTaskStatus








This DVM transforms the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity UDF type Object ID and title.




	
WAM_WorkOrderTaskStatus


	
P6_ActivityStatus





	
This is work order task status in Oracle Utilities Work and Asset Management.


	
This is the Activity status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.9


	
WAMP6_WorkOrderTaskUDF








This DVM transforms the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity UDF type object ID and title.




	
WAM_WorkOrderTaskUDFCode


	
P6_ActivityUDFTypeTitle


	
P6_ActivityUDFTypeObjectID





	
This is the work order task level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the Activity level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the object ID of the Activity level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.10


	
WAMP6_Relationship








This DVM transforms the Oracle Utilities Work and Asset Management Relationship Code to a Primavera P6 Enterprise Project Portfolio Management Relationship type object ID.




	
WAM_RelationshipCode


	
P6_RelationshipType





	
This is relationship code in Oracle Utilities Work and Asset Management.


	
This is the relationship type in Primavera P6 Enterprise Project Portfolio Management.












3 Configuring the Integration

This section provides details regarding the configuration settings required for the integration, and also discusses in detail the following:




	
•


	
Integration Configuration Checklist











	
•


	
Setting up Primavera P6 Enterprise Project Portfolio Management











	
•


	
Setting Up Oracle Utilities Work and Asset Management











	
•


	
Setting up the Process Integration











	
3.1


	
Integration Configuration Checklist








Configuration is required to implement the integration between Primavera P6 Enterprise Project Portfolio Management and Oracle Utilities Work and Asset Management. For complete details see the following sections:




	
•


	
Primavera P6 Enterprise Project Portfolio Management Configuration Checklist











	
•


	
Oracle Utilities Work and Asset Management Configuration Checklist











	
•


	
Integration Product Configuration Checklist








Note: Please refer to the product documentation for Oracle Utilities Work and Asset Management or for Primavera P6 Enterprise Project Portfolio Management for complete configuration information.




	
3.1.1


	
Primavera P6 Enterprise Project Portfolio Management Configuration Checklist








Configure the EPS, UDFs and security in Primavera P6 Enterprise Project Portfolio Management:




	
•


	
Configure Enterprise Project Structure (EPS)











	
•


	
Configure User-Defined Fields (UDFs) Labor Sequence Number is mandatory. Others are optional.











	
•


	
Configure Security













	
3.1.2


	
Oracle Utilities Work and Asset Management Configuration Checklist








Configure the necessary business rules, batch jobs, security functions and modules related to Oracle Utilities Work and Asset Management functionality:




	
•


	
Configure Business Rules











	
•


	
Configure the Integration Batch Job











	
•


	
Configure Responsibility Settings











	
•


	
Configure Required Fields











	
3.1.3


	
Integration Product Configuration Checklist








In the integration layer, you must configure the configuration properties file, system properties, and domain value maps.




	
•


	
Configure Configuration Properties - Updates ConfigurationProperties.xml file











	
•


	
Configure System Properties - Sets Module Configurations properties that are shared by multiple integration points and Service Configurations properties that are used by a specific BPEL process.











	
•


	
Configure Domain Value Maps - Sets Domain value maps (DVMs) to map codes and other static values across applications.













	
3.2


	
Setting up Primavera P6 Enterprise Project Portfolio Management








To set up Primavera P6 Enterprise Project Portfolio Management (EPPM) for the integration, configure the following:




	
•


	
Configure Enterprise Project Structure (EPS)











	
•


	
Configure User-Defined Fields (UDFs)











	
•


	
Configure Security








Configure Enterprise Project Structure (EPS)

Enterprise Project Structure (EPS) must be created in Primavera P6 Enterprise Project Portfolio Management. EPS is similar to Plant in Oracle Utilities Work and Asset Management in that it organizes the application into "work sites" or "areas". Projects are created for the EPS name sent from Oracle Utilities Work and Asset Management.

To Set Up EPS for the Integration




	
1.


	
Create a new EPS in Primavera P6 Enterprise Project Portfolio Management.








Multiple EPS can be used to create projects in Primavera P6 Enterprise Project Portfolio Management. Oracle Utilities Work and Asset Management sends the EPS name in the request which is transformed to EPS Object ID by using the WAMP6_EPS DVM.




	
2.


	
Add the EPS Name and EPS Object ID mapping in the WAMP6_EPS DVM.











	
3.2.1


	
Configure User-Defined Fields (UDFs)








Primavera P6 Enterprise Project Portfolio Management User Defined Fields (UDFs) are used to create fields that are not sent over to Oracle Utilities Work and Asset Management by the integration as part of the base package.

If needed, you can create UDFs in Primavera P6 Enterprise Project Portfolio Management and populate additional Oracle Utilities Work and Asset Management fields. For example, if on the project the Oracle Utilities Work and Asset Management record includes an CONTACT_NAME. This would not be sent to Primavera P6 Enterprise Project Portfolio Management as part of the base integration, however a UDF can be created in Primavera P6 Enterprise Project Portfolio Management called P6-WAM_RESOURCE to capture the field in the integration.

A UDF for Labor Sequence Number must be configured before the Project data can be sent from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management. The other UDFs mentioned below are suggested for base level fields that should be created at the onset of your implementation, but they are optional.

UDF Type - Labor Sequence Number (Required)

Oracle Utilities Work and Asset Management sends the labor sequence number in the Create and Update project request. The labor sequence number is stored in Primavera P6 Enterprise Project Portfolio Management as a UDF for Resource Assignment.

To Create a UDF Type for Resource Assignment




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as Administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Resources > Assignment UDF.











	
3.


	
Add the UDF Type title and Object ID in the ConfigurationProperties > Module Configuration section.











	
4.


	
Update the following Properties:











	
•


	
P6.ResourceAssignment











	
•


	
UDFType.Name











	
•


	
P6.ResourceAssignment.UDFType.ObjectID











	
5.


	
Update MDS to ensure that the updated ConfigurationProperties.xml is loaded.








UDF Type - Project

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the project level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the Project level, and the details must be associated with the Project user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_ProjectUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > Project UDF.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_ProjectUDF DVM.








UDF Type - Sub Project (WBS)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the sub project level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the WBS level and the details must be associated with the WBS user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_SubprojectUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > SubprojectUDF DVM.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_SubprojectUDF DVM.








UDF Type - Work Order (WBS)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the Work Order level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the WBS level, and the details must be associated with the WBS user defined attribute in Oracle Utilities Work and Asset Management using the  WAMP6_WorkOrderUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > WBS UDFs.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_WorkOrderUDF DVM.








UDF Type - Work Order Task (Activity)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the Work Order Task level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the Activity level, and the details must be associated with the Activity user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_WorkOrderTaskUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > WBS UDFs.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_WorkOrderUDF DVM.








Note : The Primavera P6 Enterprise Project Portfolio Management web services can be used to get the Object ID for a newly created object. Use the appropriate web service > Read operation to get the Object ID.




	
3.2.2


	
Configure Security








This integration supports Web Service Security with user name token and the security setup needs to be done in Primavera P6 Enterprise Project Portfolio Management.

To Configure Primavera P6 Enterprise Project Portfolio Management Security




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as Administrator.











	
2.


	
Navigate to Configurations > Custom > Primavera P6 Configuration > Web Services > Security to set the following field values:











	
•


	
Authentication > Mode = Username Token Profile











	
•


	
Authentication > UserName Token Profile > Nonce > Require Nonce = false











	
•


	
Authentication > UserName Token Profile > Created > Require Created = false











	
•


	
Message Protection > Require Timestamp = false











	
•


	
Message Protection > Require Digital Signatures for Incoming Messages = false











	
•


	
Message Protection > Require Encryption for Incoming Messages = false











	
•


	
Message Protection > Encrypt Response = false











	
3.3


	
Setting Up Oracle Utilities Work and Asset Management








The configuration tasks in Oracle Utilities Work and Asset Management include:




	
•


	
Configure Business Rules











	
•


	
Configure the Integration Batch Job











	
•


	
Configure Responsibility Settings











	
•


	
Configure Required Fields








The following sections provide a general overview of these steps:




	
3.3.1


	
Configure Business Rules








Configure the Oracle Utilities Work and Asset Management business rules as indicated below.




	
3.3.1.1


	
Project Management Business Rule








Configure the following rule keys:




	
•


	
DEFAULT SUBPROJECT TYPE - Stores the user-defined default for subproject type for any new subproject record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration.











	
•


	
DEFAULT WORK ORDER ACCOUNT - Stores the user-defined default for account number for any new work order record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration.











	
•


	
DEFAULT WORK ORDER TYPE - Stores the default for work order type for any new work order record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration. The default is "R" for regular work order type.











	
•


	
PRIMAVERA_P6 - Indicates whether the Primavera P6 Enterprise Project Portfolio Management integration is ON/OFF (Default option is ON). Also, it stores the user-defined URL to launch the Primavera P6 Enterprise Project Portfolio Management application. This URL can also be overridden on the User Profile record as well.











	
•


	
PRIMAVERA_P6_EPS_NAME - Stores the user-defined name of the Primavera P6 Enterprise Project Portfolio Management EPS. This establishes the default EPS name that is used at the project level on projects created in Oracle Utilities Work and Asset Management. EPS needs to be setup in Primavera P6 Enterprise Project Portfolio Management before the integration can function. If necessary, users can override this name in their own User Profile record. There is also an EPS DVM which manages the mapping between the EPS name entered here, and the Object ID used by the Primavera P6 Enterprise Project Portfolio Management web service.











	
•


	
PRIMAVERA_RESOURCES_SYNCH - Indicates whether to send updates of the CRAFT RATES business rule to Primavera P6 Enterprise Project Portfolio Management. The option is ON/OFF with the default option as OFF.











	
•


	
PRIMAVERA_WORK_STATUS_UPDATE - Indicates whether updates from Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management work order statuses are allowed. The option is ON/OFF with the default option as OFF.











	
3.3.1.2


	
Craft Rates Business Rule








The Craft Rates business rule is synchronized with Primavera P6 Enterprise Project Portfolio Management using the wifp_primavera_synch_resources batch job, so the rule does not need to be configured directly You can choose to update this rule manually using settings in the Project Management business rule via the PRIMAVERA_RESOURCES_SYNCH rule key (see above).




	
3.3.1.3


	
Web Services Gateway Business Rule








Configure the following rule keys:




	
•


	
PRIMAVERA CREATE PROJECT - This stores the setup information to the integration Service-Oriented Architecture (SOA) server for the Create Project service.











	
•


	
PRIMAVERA RETRIEVE PROJECT - This stores the setup information to the integration SOA server for the Retrieve Project service.











	
•


	
PRIMAVERA SYNCH RESOURCES - This stores the setup information to the integration SOA server for the Craft-Resources synch service.











	
•


	
PRIMAVERA UPDATE PROJECT - This stores the setup information to the integration SOA server for the Update Project service.











	
•


	
Enter a Log Level in the last column to have errors for the related setting written to an error log.








Note: Each rule key must have the Username, Password, Service URL, and GateWay URL.




	
3.3.2


	
Configure the Integration Batch Job








The batch job, wifp_primavera_synch_resouces sends values from the Craft Rates business rule to the integration.

Name: wifp_primavera_synch_resouces

Parameters:




	
•


	
Job Number (Example: 43)











	
•


	
Plant code (Example: 01)











	
•


	
"O" (only supports outbound interface) (Example: O)











	
•


	
"N" (parameter is a placeholder and not used) "(Example: N)











	
•


	
This parameter can be used to pass one CRAFT code to synchronize; otherwise, set to NULL (Example: null).











	
•


	
This parameter used to set custom Pre-processor PL/SQL procedure/package name, if any; otherwise set to NULL (Example: null).











	
•


	
This parameter used to set custom Post-processor PL/SQL procedure/package name, if any; otherwise set to NULL (Example: null).











	
3.3.3


	
Configure Responsibility Settings








Access to functionality is managed through the Responsibility module in Oracle Utilities Work and Asset Management. There are three security functions that must be assigned to a Responsibility (which is in turn assigned to a user) to give access to use this integration:




	
•


	
PROJECT MANAGEMENT - Allows access to the Project Management view on the Oracle Utilities Work and Asset Management Project.











	
•


	
PRIMAVERA EXPORT - Allows access to the action to export projects from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.











	
•


	
PRIMAVERA IMPORT - Allows access to the action to import projects from Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management.











	
3.3.4


	
Configure Required Fields








Primavera P6 Enterprise Project Portfolio Management Activity relationships require a relationship code. To ensure that this code is filled correctly by users, set these as required fields in the Oracle Utilities Work and Asset Management Work Order and Work Order Task modules.

To Set Required Fields in Oracle Utilities Work and Asset Management




	
1.


	
Open the Modules Administration module.











	
2.


	
Search for the Form Description " Work Order Task".











	
3.


	
Select Work Order in the Results of Search list.











	
4.


	
Select Required Fields from the Views list.











	
5.


	
Select the Block Names: TASK_PREDECESSOR and TASK_SUCCESSOR











	
6.


	
Set the RELATIONSHIP_CODE field " Required" with a suitable default value.











	
7.


	
Repeat this process for the Work Order module.











	
3.4


	
Setting up the Process Integration








The following sections describe how to configure integration pack to meet the requirements for a two-way integration.

Configuration steps include setting the following:




	
•


	
Configure Configuration Properties











	
•


	
Configure System Properties











	
•


	
Configure Domain Value Maps











	
3.4.1


	
Configure Configuration Properties








The ConfigurationProperties.XML file contains properties which can be defaulted in the integration. It also contains flags to enable extension points within the integration.

ConfigurationProperties.XML is located in MDS under the directory apps/P6-Oracle Utilities Work and Asset Management/AIAMetaData/config.

Note : Whenever the ConfigurationProperties.XML file is updated, it must be reloaded to the MDS repository so that update is reflected in applications or services which use these updated properties. Reload the SOA server by rebooting.




	
3.4.2


	
Configure System Properties








Two sets of configuration properties are described in this section:




	
•


	
Module Configuration are the properties shared by multiple integration points within this integration.











	
•


	
Service Configuration are the properties used by a specific BPEL process.











	
3.4.2.1


	
Module Configuration








Module Configuration has application level properties, which are used by all SOA composites.

Module Configuration Details




	
Module Name


	
Default / Shipped Value


	
Description





	
WAM.success.ErrorCode


	
0


	
Success code sent to Oracle Utilities Work and Asset Management from the integration layer.





	
WAM.success.ErrorDescription


	
SUCCESS


	
Success description sent to Oracle Utilities Work and Asset Management from the integration layer.





	
P6.Create.ImportOption


	
Keep Existing


	
Import option sent to Primavera P6 Enterprise Project Portfolio Management import service from the integration layer.





	
P6.ResourceAssignment.UDFType.Name


	
LaborSequenceNo


	
Assignment UDF Type defined in Primavera P6 Enterprise Project Portfolio Management to store the Labor sequence number. The UDF should be created before any data is sent across from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.





	
P6.ResourceAssignment.UDFType.ObjectID


	



	
Object ID generated and assigned by Primavera P6 Enterprise Project Portfolio Management to the Assignment UDF Type, which is defined in Primavera P6 Enterprise Project Portfolio Management to store the Labor sequence number. The UDFType Object ID must be set before any data is sent across from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.





	
P6.Project.Attachment.Size


	
1024


	
Used internally. Do not change this value.





	
P6.PercentComplete.Type


	
Physical


	
This property is sent to Primavera P6 Enterprise Project Portfolio Management to indicate the Percent Completion type being sent by Oracle Utilities Work and Asset Management. Currently Oracle Utilities Work and Asset Management only supports Physical percent complete. Primavera P6 Enterprise Project Portfolio Management supports Duration and Units percent complete, however this is not supported in the current integration.









	
3.4.2.2


	
Service Configuration








Service Configuration properties are specific to the SOA composites. These are used to make changes in a specific composite behavior.

Service Configuration Details




	
ServiceName


	
Property Name


	
Default Value


	
Description





	
OUWAMP6UpdateCraftRatesEBF





	



	
Prim.CraftsandRates.Technical.ErrorCode


	
1007


	
Error code send back to Oracle Utilities Work and Asset Management from integration layer for errors in the Update Craft and Rates EBS.





	



	
Prim.CraftsandRates.Technical.ErrorDescription


	
Technical Error from Primavera P6 Enterprise Project Portfolio Management


	
Error description sent back to Oracle Utilities Work and Asset Management from integration layer for errors in the Update Craft and Rates EBF. This can be modified by the implementation team.





	





	
Primavera.Resource.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ResourceService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management resource service. This can be modified by the implementation team.





	



	
Primavera.Resource.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/Resource/V1}ResourceService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management resource service.





	



	
Primavera.Resource.PortType


	
ResourcePortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management resource service.





	



	
Primavera.Rate.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ResourceRateService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management resource rate service. This can be modified by the implementation team.





	



	
Primavera.Rate.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/ResourceRate/V1}ResourceRateService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management resource rate service.





	



	
Primavera.Rate.PortType


	
ResourceRatePortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management resource rate service.





	
OUWAMP6CreateProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to the Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.CreateProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ImportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management import service. This can be modified by the implementation team.





	



	
P6.CreateProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSImport/V1}ImportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.CreateProj.PortType


	
ImportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.DefaultGlobalImportOption


	
Create New


	
Default global import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.DefaultProjectSpecificImportOption


	
Create New


	
Default project specific import iption for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.FileType


	
XML


	
File type format for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.IgnoreGUID


	
True


	
Ignore GUID option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.IgnoreSequenceNumber


	
True


	
Ignore sequence number option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.LogLevel


	
INFO


	
Log level option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.Create.ErrorCode


	
1001


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the import service 'Create Project operation fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Create.Retrieve.ErrorCode


	
1002


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the export service fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Create.Craft.ErrorCode


	
1006


	
Error code sent by integration to Oracle Utilities Work and Asset Management, if the integration layer is not able to find Crafts in the Integration Craft and Rates mapping table.





	



	
P6.Create.Craft.ErrorDescription


	
Plant Craft combination does not exist


	
The description for the property P6.Create.Craft.ErrorCode which has the error code. Implementation team can change this description.





	



	
P6.Create.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Update.Technical.ErrorDescription


	
Technical errorfrom middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.





	
OUWAMP6UpdateProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.UpdateProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ImportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management import service. This can be modified by the implementation team.





	



	
P6.UpdateProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSImport/V1}ImportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.UpdateProj.PortType


	
ImportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.DefaultGlobalImportOption


	
Update Existing


	
Default global import option





	



	
Prim.DefaultProjectSpecificImportOption


	
Update Existing


	
Default project specific import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.FileType


	
XML


	
File type format for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.IgnoreGUID


	
true


	
Ignore GUID option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.IgnoreSequenceNumber


	
true


	
Ignore sequence number option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.LogLevel


	
INFO


	
Log level option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.Update.ErrorCode


	
1003


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the import service 'Update Project operation fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Update.Retrieve.ErrorCode


	
1004


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the export service fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Update.Craft.ErrorCode


	
1006


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the integration layer is not able to find Crafts in the Integration Craft and Rates mapping table.





	



	
P6.Update.Craft.ErrorDescription


	
Plant Craft combination does not exist


	
The description for the property P6.Update.Craft.ErrorCode which has the error code. Implementation team can change this description.





	



	
P6.Update.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Update.Technical.ErrorDescription


	
Technical error from middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.





	



	
P6.Update.ImportOption


	
Keep Existing


	
Import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	
OUWAMP6RetrieveProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
false


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
false


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
false


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
false


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.RetrieveProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ExportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management export service. This can be modified by the implementation team.





	



	
P6.RetrieveProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSExport/V2}ExportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
P6.RetrieveProj.PortType


	
ExportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.Encoding


	
UTF-8


	
Encoding option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.LineSeparator


	
Unix


	
LineSeparator option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.SpreadPeriodType


	
Day


	
SpreadPeriodType option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.Spacing


	



	
Spacing option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.FileType


	
XML


	
FileType option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
P6.Retrieve.ErrorCode


	
1005


	
Error code sent by integration to Oracle Utilities Work and Asset Management for Primavera P6 Enterprise Project Portfolio Management Export service failure.





	



	
P6.Retrieve.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Retrieve.Technical.ErrorDescription


	
Technical error from middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.









	
3.4.3


	
Configure Domain Value Maps








Domain value maps (DVMs) are a standard feature of the Oracle SOA Suite. They map codes and other static values across applications.

For example: Different types of country codes configured in each of the applications can be mapped using a DVM. Country code for USA can be "US" in one application and map to "USA" in the other application.

DVMs are static in nature, though administrators can add additional maps as needed. Transactional business processes never update the Domain Value Maps (DVMs). Instead they only read from DVMs. They are stored in the XML files and cached in memory at runtime.

To Maintain Information within Domain Value Maps




	
1.


	
Open a browser and access the SOA Composer application ( http://host:port/soa/composer/)).











	
2.


	
On the SOA Composer, select Open from the drop-down list and select Open DVM.The list of all DVM files in the MDS repository is displayed.











	
3.


	
Select the relevant DVM you wish to maintain.











	
4.


	
Edit the selected DVM by clicking the Edit button in the top navigation bar for editing DVM.











	
5.


	
Once the DVM is edited, click Save in the navigation bar. This saves the DVM data for that session.











	
6.


	
Click Commit after updating each DVM.This saves the DVM data in the MDS repository.








The DVMs for the integration are described below. Each object refers to a valid object defined in Primavera P6 Enterprise Project Portfolio Management and a valid object defined in Oracle Utilities Work and Asset Management, as applicable:

Domain Value Code Details for the Integration Points




	
DVM


	
Integration Points


	
Description





	
WAMP6_EPS


	
Create Project and Retrieve Project Details


	
Maps the Primavera P6 Enterprise Project Portfolio Management EPS name stored in Oracle Utilities Work and Asset Management to the Primavera P6 Enterprise Project Portfolio Management EPS Object ID for that EPS in Primavera P6 Enterprise Project Portfolio Management and vice versa.





	
WAMP6_ProjectStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Project status to Primavera P6 Enterprise Project Portfolio Management Project status and vice versa.





	
WAMP6_ProjectUDF


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Project UDF Code to Primavera P6 Enterprise Project Portfolio Management Project UDF type Object ID and title.





	
WAMP6_SubprojectStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Sub Project status to Primavera P6 Enterprise Project Portfolio Management WBS status.





	
WAMP6_SubprojectUDF


	
WAMP6_SubprojectUDF


	
Maps the Oracle Utilities Work and Asset Management Sub Project UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type. object id and title





	
WAMP6_WorkOrderTaskStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order status to Primavera P6 Enterprise Project Portfolio Management. Management WBS status.





	
WAMP6_WorkOrderUDF


	
Create Project, Update Project., and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type.

 object id and title





	
WAMP6_WorkOrderTaskStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order Task status to Primavera P6 Enterprise Project Portfolio Management. Management Activity status.







	
WAMP6_WorkOrderTaskUDF


	
Create Project, Update Project, and Retrieve Project details.


	
Maps the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity. UDF type Object ID and title.







	
WAMP6_Relationship


	
Create Project, Update Project and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Relationship Code to Primavera P6 Enterprise Project Portfolio Management Relationship type. Object ID.









	
3.4.3.1


	
WAMP6_EPS








This DVM transforms a Primavera P6 Enterprise Project Portfolio Management EPS name stored in Oracle Utilities Work and Asset Management to a Primavera P6 Enterprise Project Portfolio Management EPS Object ID.




	
WAM_EPSName


	
P6_EPSObjectID





	
This is the Primavera P6 Enterprise Project Portfolio Management EPS Name stored in the Oracle Utilities Work and Asset Management Project Management business rule.


	
This is the EPS Object ID corresponding to the EPS name stored in Oracle Utilities Work and Asset Management.









	
3.4.3.2


	
WAMP6_ProjectStatus








This DVM transforms the Oracle Utilities Work and Asset Management Project Status to Primavera P6 Enterprise Project Portfolio Management Project Status and vice versa.




	
WAM_ProjectStatus


	
P6_ProjectStatus





	
This is project status in Oracle Utilities Work and Asset Management.


	
This is the project status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.3


	
WAMP6_ProjectUDF








This DVM transforms the Oracle Utilities Work and Asset Management Project UDF Code to Primavera P6 Enterprise Project Portfolio Management Project UDF type Object ID and title.




	
WAM_ProjectUDFCode


	
P6_ProjectUDFTypeTitle


	
P6_ProjectUDFTypeObjectID





	
This is the project level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the project level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the project level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.4


	
WAMP6_SubprojectStatus








This DVM transforms the Oracle Utilities Work and Asset Management Subproject status to Primavera P6 Enterprise Project Portfolio Management Work Breakdown Structure (WBS) status and vice versa.




	
WAM_SubprojectStatus


	
P6_WBSStatus





	
This is sub project status in Oracle Utilities Work and Asset Management.


	
This is the WBS status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.5


	
WAMP6_SubprojectUDF








This DVM transforms the Oracle Utilities Work and Asset Management Subproject UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type Object ID and title.




	
WAM_SubprojectUDFCode


	
P6_WBSUDFTypeTitle


	
P6_WBSUDFTypeObjectID





	
 This is the sub project level UDF attribute name in Oracle Utilities Work and Asset Management. For example, ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.6


	
WAMP6_WorkOrderStatus








This DVM transforms the Oracle Utilities Work and Asset Management Work Order status to Primavera P6 Enterprise Project Portfolio Management Work Breakdown Structure (WBS) status and vice versa.




	
WAM_WorkOrderStatus


	
P6_WBSStatus





	
This is work order status in Oracle Utilities Work and Asset Management.


	
This is the WBS status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.7


	
WAMP6_WorkOrderUDF








This DVM transforms the Oracle Utilities Work and Asset Management Work Order UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type Object ID and title.




	
WAM_WorkOrderUDFCode


	
P6_WBSUDFTypeTitle


	
P6_WBSUDFTypeObjectID





	
This is the work order level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.8


	
WAMP6_WorkOrderTaskStatus








This DVM transforms the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity UDF type Object ID and title.




	
WAM_WorkOrderTaskStatus


	
P6_ActivityStatus





	
This is work order task status in Oracle Utilities Work and Asset Management.


	
This is the Activity status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.9


	
WAMP6_WorkOrderTaskUDF








This DVM transforms the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity UDF type object ID and title.




	
WAM_WorkOrderTaskUDFCode


	
P6_ActivityUDFTypeTitle


	
P6_ActivityUDFTypeObjectID





	
This is the work order task level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the Activity level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the object ID of the Activity level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.10


	
WAMP6_Relationship








This DVM transforms the Oracle Utilities Work and Asset Management Relationship Code to a Primavera P6 Enterprise Project Portfolio Management Relationship type object ID.




	
WAM_RelationshipCode


	
P6_RelationshipType





	
This is relationship code in Oracle Utilities Work and Asset Management.


	
This is the relationship type in Primavera P6 Enterprise Project Portfolio Management.












3 Configuring the Integration

This section provides details regarding the configuration settings required for the integration, and also discusses in detail the following:




	
•


	
Integration Configuration Checklist











	
•


	
Setting up Primavera P6 Enterprise Project Portfolio Management











	
•


	
Setting Up Oracle Utilities Work and Asset Management











	
•


	
Setting up the Process Integration











	
3.1


	
Integration Configuration Checklist








Configuration is required to implement the integration between Primavera P6 Enterprise Project Portfolio Management and Oracle Utilities Work and Asset Management. For complete details see the following sections:




	
•


	
Primavera P6 Enterprise Project Portfolio Management Configuration Checklist











	
•


	
Oracle Utilities Work and Asset Management Configuration Checklist











	
•


	
Integration Product Configuration Checklist








Note: Please refer to the product documentation for Oracle Utilities Work and Asset Management or for Primavera P6 Enterprise Project Portfolio Management for complete configuration information.




	
3.1.1


	
Primavera P6 Enterprise Project Portfolio Management Configuration Checklist








Configure the EPS, UDFs and security in Primavera P6 Enterprise Project Portfolio Management:




	
•


	
Configure Enterprise Project Structure (EPS)











	
•


	
Configure User-Defined Fields (UDFs) Labor Sequence Number is mandatory. Others are optional.











	
•


	
Configure Security













	
3.1.2


	
Oracle Utilities Work and Asset Management Configuration Checklist








Configure the necessary business rules, batch jobs, security functions and modules related to Oracle Utilities Work and Asset Management functionality:




	
•


	
Configure Business Rules











	
•


	
Configure the Integration Batch Job











	
•


	
Configure Responsibility Settings











	
•


	
Configure Required Fields











	
3.1.3


	
Integration Product Configuration Checklist








In the integration layer, you must configure the configuration properties file, system properties, and domain value maps.




	
•


	
Configure Configuration Properties - Updates ConfigurationProperties.xml file











	
•


	
Configure System Properties - Sets Module Configurations properties that are shared by multiple integration points and Service Configurations properties that are used by a specific BPEL process.











	
•


	
Configure Domain Value Maps - Sets Domain value maps (DVMs) to map codes and other static values across applications.













	
3.2


	
Setting up Primavera P6 Enterprise Project Portfolio Management








To set up Primavera P6 Enterprise Project Portfolio Management (EPPM) for the integration, configure the following:




	
•


	
Configure Enterprise Project Structure (EPS)











	
•


	
Configure User-Defined Fields (UDFs)











	
•


	
Configure Security








Configure Enterprise Project Structure (EPS)

Enterprise Project Structure (EPS) must be created in Primavera P6 Enterprise Project Portfolio Management. EPS is similar to Plant in Oracle Utilities Work and Asset Management in that it organizes the application into "work sites" or "areas". Projects are created for the EPS name sent from Oracle Utilities Work and Asset Management.

To Set Up EPS for the Integration




	
1.


	
Create a new EPS in Primavera P6 Enterprise Project Portfolio Management.








Multiple EPS can be used to create projects in Primavera P6 Enterprise Project Portfolio Management. Oracle Utilities Work and Asset Management sends the EPS name in the request which is transformed to EPS Object ID by using the WAMP6_EPS DVM.




	
2.


	
Add the EPS Name and EPS Object ID mapping in the WAMP6_EPS DVM.











	
3.2.1


	
Configure User-Defined Fields (UDFs)








Primavera P6 Enterprise Project Portfolio Management User Defined Fields (UDFs) are used to create fields that are not sent over to Oracle Utilities Work and Asset Management by the integration as part of the base package.

If needed, you can create UDFs in Primavera P6 Enterprise Project Portfolio Management and populate additional Oracle Utilities Work and Asset Management fields. For example, if on the project the Oracle Utilities Work and Asset Management record includes an CONTACT_NAME. This would not be sent to Primavera P6 Enterprise Project Portfolio Management as part of the base integration, however a UDF can be created in Primavera P6 Enterprise Project Portfolio Management called P6-WAM_RESOURCE to capture the field in the integration.

A UDF for Labor Sequence Number must be configured before the Project data can be sent from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management. The other UDFs mentioned below are suggested for base level fields that should be created at the onset of your implementation, but they are optional.

UDF Type - Labor Sequence Number (Required)

Oracle Utilities Work and Asset Management sends the labor sequence number in the Create and Update project request. The labor sequence number is stored in Primavera P6 Enterprise Project Portfolio Management as a UDF for Resource Assignment.

To Create a UDF Type for Resource Assignment




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as Administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Resources > Assignment UDF.











	
3.


	
Add the UDF Type title and Object ID in the ConfigurationProperties > Module Configuration section.











	
4.


	
Update the following Properties:











	
•


	
P6.ResourceAssignment











	
•


	
UDFType.Name











	
•


	
P6.ResourceAssignment.UDFType.ObjectID











	
5.


	
Update MDS to ensure that the updated ConfigurationProperties.xml is loaded.








UDF Type - Project

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the project level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the Project level, and the details must be associated with the Project user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_ProjectUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > Project UDF.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_ProjectUDF DVM.








UDF Type - Sub Project (WBS)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the sub project level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the WBS level and the details must be associated with the WBS user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_SubprojectUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > SubprojectUDF DVM.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_SubprojectUDF DVM.








UDF Type - Work Order (WBS)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the Work Order level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the WBS level, and the details must be associated with the WBS user defined attribute in Oracle Utilities Work and Asset Management using the  WAMP6_WorkOrderUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > WBS UDFs.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_WorkOrderUDF DVM.








UDF Type - Work Order Task (Activity)

Oracle Utilities Work and Asset Management sends the user defined fields in the Create and Update project request at the Work Order Task level. These fields are named ATTRIBUTE1 to ATTRIBUTE10 and can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management. To store these fields in Primavera P6 Enterprise Project Portfolio Management, the UDF Types should be created at the Activity level, and the details must be associated with the Activity user defined attribute in Oracle Utilities Work and Asset Management using the WAMP6_WorkOrderTaskUDF DVM.

To Create UDF Types for ATTRIBUTE1 to ATTRIBUTE10




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as administrator.











	
2.


	
Navigate to Administer > Enterprise Data > Projects > WBS UDFs.











	
3.


	
Add the UDF Type title and Object ID to the appropriate Oracle Utilities Work and Asset Management attribute row in the WAMP6_WorkOrderUDF DVM.








Note : The Primavera P6 Enterprise Project Portfolio Management web services can be used to get the Object ID for a newly created object. Use the appropriate web service > Read operation to get the Object ID.




	
3.2.2


	
Configure Security








This integration supports Web Service Security with user name token and the security setup needs to be done in Primavera P6 Enterprise Project Portfolio Management.

To Configure Primavera P6 Enterprise Project Portfolio Management Security




	
1.


	
Log in to Primavera P6 Enterprise Project Portfolio Management as Administrator.











	
2.


	
Navigate to Configurations > Custom > Primavera P6 Configuration > Web Services > Security to set the following field values:











	
•


	
Authentication > Mode = Username Token Profile











	
•


	
Authentication > UserName Token Profile > Nonce > Require Nonce = false











	
•


	
Authentication > UserName Token Profile > Created > Require Created = false











	
•


	
Message Protection > Require Timestamp = false











	
•


	
Message Protection > Require Digital Signatures for Incoming Messages = false











	
•


	
Message Protection > Require Encryption for Incoming Messages = false











	
•


	
Message Protection > Encrypt Response = false











	
3.3


	
Setting Up Oracle Utilities Work and Asset Management








The configuration tasks in Oracle Utilities Work and Asset Management include:




	
•


	
Configure Business Rules











	
•


	
Configure the Integration Batch Job











	
•


	
Configure Responsibility Settings











	
•


	
Configure Required Fields








The following sections provide a general overview of these steps:




	
3.3.1


	
Configure Business Rules








Configure the Oracle Utilities Work and Asset Management business rules as indicated below.




	
3.3.1.1


	
Project Management Business Rule








Configure the following rule keys:




	
•


	
DEFAULT SUBPROJECT TYPE - Stores the user-defined default for subproject type for any new subproject record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration.











	
•


	
DEFAULT WORK ORDER ACCOUNT - Stores the user-defined default for account number for any new work order record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration.











	
•


	
DEFAULT WORK ORDER TYPE - Stores the default for work order type for any new work order record created in Oracle Utilities Work and Asset Management from Primavera P6 Enterprise Project Portfolio Management import integration. The default is "R" for regular work order type.











	
•


	
PRIMAVERA_P6 - Indicates whether the Primavera P6 Enterprise Project Portfolio Management integration is ON/OFF (Default option is ON). Also, it stores the user-defined URL to launch the Primavera P6 Enterprise Project Portfolio Management application. This URL can also be overridden on the User Profile record as well.











	
•


	
PRIMAVERA_P6_EPS_NAME - Stores the user-defined name of the Primavera P6 Enterprise Project Portfolio Management EPS. This establishes the default EPS name that is used at the project level on projects created in Oracle Utilities Work and Asset Management. EPS needs to be setup in Primavera P6 Enterprise Project Portfolio Management before the integration can function. If necessary, users can override this name in their own User Profile record. There is also an EPS DVM which manages the mapping between the EPS name entered here, and the Object ID used by the Primavera P6 Enterprise Project Portfolio Management web service.











	
•


	
PRIMAVERA_RESOURCES_SYNCH - Indicates whether to send updates of the CRAFT RATES business rule to Primavera P6 Enterprise Project Portfolio Management. The option is ON/OFF with the default option as OFF.











	
•


	
PRIMAVERA_WORK_STATUS_UPDATE - Indicates whether updates from Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management work order statuses are allowed. The option is ON/OFF with the default option as OFF.











	
3.3.1.2


	
Craft Rates Business Rule








The Craft Rates business rule is synchronized with Primavera P6 Enterprise Project Portfolio Management using the wifp_primavera_synch_resources batch job, so the rule does not need to be configured directly You can choose to update this rule manually using settings in the Project Management business rule via the PRIMAVERA_RESOURCES_SYNCH rule key (see above).




	
3.3.1.3


	
Web Services Gateway Business Rule








Configure the following rule keys:




	
•


	
PRIMAVERA CREATE PROJECT - This stores the setup information to the integration Service-Oriented Architecture (SOA) server for the Create Project service.











	
•


	
PRIMAVERA RETRIEVE PROJECT - This stores the setup information to the integration SOA server for the Retrieve Project service.











	
•


	
PRIMAVERA SYNCH RESOURCES - This stores the setup information to the integration SOA server for the Craft-Resources synch service.











	
•


	
PRIMAVERA UPDATE PROJECT - This stores the setup information to the integration SOA server for the Update Project service.











	
•


	
Enter a Log Level in the last column to have errors for the related setting written to an error log.








Note: Each rule key must have the Username, Password, Service URL, and GateWay URL.




	
3.3.2


	
Configure the Integration Batch Job








The batch job, wifp_primavera_synch_resouces sends values from the Craft Rates business rule to the integration.

Name: wifp_primavera_synch_resouces

Parameters:




	
•


	
Job Number (Example: 43)











	
•


	
Plant code (Example: 01)











	
•


	
"O" (only supports outbound interface) (Example: O)











	
•


	
"N" (parameter is a placeholder and not used) "(Example: N)











	
•


	
This parameter can be used to pass one CRAFT code to synchronize; otherwise, set to NULL (Example: null).











	
•


	
This parameter used to set custom Pre-processor PL/SQL procedure/package name, if any; otherwise set to NULL (Example: null).











	
•


	
This parameter used to set custom Post-processor PL/SQL procedure/package name, if any; otherwise set to NULL (Example: null).











	
3.3.3


	
Configure Responsibility Settings








Access to functionality is managed through the Responsibility module in Oracle Utilities Work and Asset Management. There are three security functions that must be assigned to a Responsibility (which is in turn assigned to a user) to give access to use this integration:




	
•


	
PROJECT MANAGEMENT - Allows access to the Project Management view on the Oracle Utilities Work and Asset Management Project.











	
•


	
PRIMAVERA EXPORT - Allows access to the action to export projects from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.











	
•


	
PRIMAVERA IMPORT - Allows access to the action to import projects from Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management.











	
3.3.4


	
Configure Required Fields








Primavera P6 Enterprise Project Portfolio Management Activity relationships require a relationship code. To ensure that this code is filled correctly by users, set these as required fields in the Oracle Utilities Work and Asset Management Work Order and Work Order Task modules.

To Set Required Fields in Oracle Utilities Work and Asset Management




	
1.


	
Open the Modules Administration module.











	
2.


	
Search for the Form Description " Work Order Task".











	
3.


	
Select Work Order in the Results of Search list.











	
4.


	
Select Required Fields from the Views list.











	
5.


	
Select the Block Names: TASK_PREDECESSOR and TASK_SUCCESSOR











	
6.


	
Set the RELATIONSHIP_CODE field " Required" with a suitable default value.











	
7.


	
Repeat this process for the Work Order module.











	
3.4


	
Setting up the Process Integration








The following sections describe how to configure integration pack to meet the requirements for a two-way integration.

Configuration steps include setting the following:




	
•


	
Configure Configuration Properties











	
•


	
Configure System Properties











	
•


	
Configure Domain Value Maps











	
3.4.1


	
Configure Configuration Properties








The ConfigurationProperties.XML file contains properties which can be defaulted in the integration. It also contains flags to enable extension points within the integration.

ConfigurationProperties.XML is located in MDS under the directory apps/P6-Oracle Utilities Work and Asset Management/AIAMetaData/config.

Note : Whenever the ConfigurationProperties.XML file is updated, it must be reloaded to the MDS repository so that update is reflected in applications or services which use these updated properties. Reload the SOA server by rebooting.




	
3.4.2


	
Configure System Properties








Two sets of configuration properties are described in this section:




	
•


	
Module Configuration are the properties shared by multiple integration points within this integration.











	
•


	
Service Configuration are the properties used by a specific BPEL process.











	
3.4.2.1


	
Module Configuration








Module Configuration has application level properties, which are used by all SOA composites.

Module Configuration Details




	
Module Name


	
Default / Shipped Value


	
Description





	
WAM.success.ErrorCode


	
0


	
Success code sent to Oracle Utilities Work and Asset Management from the integration layer.





	
WAM.success.ErrorDescription


	
SUCCESS


	
Success description sent to Oracle Utilities Work and Asset Management from the integration layer.





	
P6.Create.ImportOption


	
Keep Existing


	
Import option sent to Primavera P6 Enterprise Project Portfolio Management import service from the integration layer.





	
P6.ResourceAssignment.UDFType.Name


	
LaborSequenceNo


	
Assignment UDF Type defined in Primavera P6 Enterprise Project Portfolio Management to store the Labor sequence number. The UDF should be created before any data is sent across from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.





	
P6.ResourceAssignment.UDFType.ObjectID


	



	
Object ID generated and assigned by Primavera P6 Enterprise Project Portfolio Management to the Assignment UDF Type, which is defined in Primavera P6 Enterprise Project Portfolio Management to store the Labor sequence number. The UDFType Object ID must be set before any data is sent across from Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management.





	
P6.Project.Attachment.Size


	
1024


	
Used internally. Do not change this value.





	
P6.PercentComplete.Type


	
Physical


	
This property is sent to Primavera P6 Enterprise Project Portfolio Management to indicate the Percent Completion type being sent by Oracle Utilities Work and Asset Management. Currently Oracle Utilities Work and Asset Management only supports Physical percent complete. Primavera P6 Enterprise Project Portfolio Management supports Duration and Units percent complete, however this is not supported in the current integration.









	
3.4.2.2


	
Service Configuration








Service Configuration properties are specific to the SOA composites. These are used to make changes in a specific composite behavior.

Service Configuration Details




	
ServiceName


	
Property Name


	
Default Value


	
Description





	
OUWAMP6UpdateCraftRatesEBF





	



	
Prim.CraftsandRates.Technical.ErrorCode


	
1007


	
Error code send back to Oracle Utilities Work and Asset Management from integration layer for errors in the Update Craft and Rates EBS.





	



	
Prim.CraftsandRates.Technical.ErrorDescription


	
Technical Error from Primavera P6 Enterprise Project Portfolio Management


	
Error description sent back to Oracle Utilities Work and Asset Management from integration layer for errors in the Update Craft and Rates EBF. This can be modified by the implementation team.





	





	
Primavera.Resource.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ResourceService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management resource service. This can be modified by the implementation team.





	



	
Primavera.Resource.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/Resource/V1}ResourceService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management resource service.





	



	
Primavera.Resource.PortType


	
ResourcePortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management resource service.





	



	
Primavera.Rate.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ResourceRateService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management resource rate service. This can be modified by the implementation team.





	



	
Primavera.Rate.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/ResourceRate/V1}ResourceRateService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management resource rate service.





	



	
Primavera.Rate.PortType


	
ResourceRatePortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management resource rate service.





	
OUWAMP6CreateProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to the Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.CreateProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ImportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management import service. This can be modified by the implementation team.





	



	
P6.CreateProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSImport/V1}ImportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.CreateProj.PortType


	
ImportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.DefaultGlobalImportOption


	
Create New


	
Default global import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.DefaultProjectSpecificImportOption


	
Create New


	
Default project specific import iption for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.FileType


	
XML


	
File type format for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.IgnoreGUID


	
True


	
Ignore GUID option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.IgnoreSequenceNumber


	
True


	
Ignore sequence number option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.LogLevel


	
INFO


	
Log level option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.Create.ErrorCode


	
1001


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the import service 'Create Project operation fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Create.Retrieve.ErrorCode


	
1002


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the export service fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Create.Craft.ErrorCode


	
1006


	
Error code sent by integration to Oracle Utilities Work and Asset Management, if the integration layer is not able to find Crafts in the Integration Craft and Rates mapping table.





	



	
P6.Create.Craft.ErrorDescription


	
Plant Craft combination does not exist


	
The description for the property P6.Create.Craft.ErrorCode which has the error code. Implementation team can change this description.





	



	
P6.Create.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Update.Technical.ErrorDescription


	
Technical errorfrom middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.





	
OUWAMP6UpdateProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
False


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
False


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.UpdateProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ImportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management import service. This can be modified by the implementation team.





	



	
P6.UpdateProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSImport/V1}ImportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.UpdateProj.PortType


	
ImportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.DefaultGlobalImportOption


	
Update Existing


	
Default global import option





	



	
Prim.DefaultProjectSpecificImportOption


	
Update Existing


	
Default project specific import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.FileType


	
XML


	
File type format for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.IgnoreGUID


	
true


	
Ignore GUID option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.IgnoreSequenceNumber


	
true


	
Ignore sequence number option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
Prim.LogLevel


	
INFO


	
Log level option for the Primavera P6 Enterprise Project Portfolio Management import service.





	



	
P6.Update.ErrorCode


	
1003


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the import service 'Update Project operation fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Update.Retrieve.ErrorCode


	
1004


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the export service fails in Primavera P6 Enterprise Project Portfolio Management.





	



	
P6.Update.Craft.ErrorCode


	
1006


	
Error code sent by integration to Oracle Utilities Work and Asset Management if the integration layer is not able to find Crafts in the Integration Craft and Rates mapping table.





	



	
P6.Update.Craft.ErrorDescription


	
Plant Craft combination does not exist


	
The description for the property P6.Update.Craft.ErrorCode which has the error code. Implementation team can change this description.





	



	
P6.Update.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Update.Technical.ErrorDescription


	
Technical error from middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.





	



	
P6.Update.ImportOption


	
Keep Existing


	
Import option for the Primavera P6 Enterprise Project Portfolio Management import service.





	
OUWAMP6RetrieveProjectEBF





	



	
Extension.PreXformWAMToPrimavera


	
false


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PostXformWAMToPrimavera


	
false


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation.





	



	
Extension.PreXformPrimaveraToWAM


	
false


	
If set to true, the pre transformation extension service is invoked. This is the Pre transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
Extension.PostXformPrimaveraToWAM


	
false


	
If set to true, the post transformation extension service is invoked. This is the Post transformation extension for the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation.





	



	
P6.RetrieveProj.EndPoint


	
http://<primaveraHost>:<primaveraPort>/p6ws/services/ExportService


	
End point URL for the Primavera P6 Enterprise Project Portfolio Management export service. This can be modified by the implementation team.





	



	
P6.RetrieveProj.ServiceName


	
{http://xmlns.oracle.com/Primavera/P6/WS/WSExport/V2}ExportService


	
Service name for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
P6.RetrieveProj.PortType


	
ExportPortType


	
Port Type for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.Encoding


	
UTF-8


	
Encoding option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.LineSeparator


	
Unix


	
LineSeparator option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.SpreadPeriodType


	
Day


	
SpreadPeriodType option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.Spacing


	



	
Spacing option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
Primavera.FileType


	
XML


	
FileType option for the Primavera P6 Enterprise Project Portfolio Management export service.





	



	
P6.Retrieve.ErrorCode


	
1005


	
Error code sent by integration to Oracle Utilities Work and Asset Management for Primavera P6 Enterprise Project Portfolio Management Export service failure.





	



	
P6.Retrieve.Technical.ErrorCode


	
1000


	
Error code sent by integration to Oracle Utilities Work and Asset Management for some unknown failure in the integration layer.





	



	
P6.Retrieve.Technical.ErrorDescription


	
Technical error from middleware


	
Error description sent by integration to Oracle Utilities Work and Asset Management.









	
3.4.3


	
Configure Domain Value Maps








Domain value maps (DVMs) are a standard feature of the Oracle SOA Suite. They map codes and other static values across applications.

For example: Different types of country codes configured in each of the applications can be mapped using a DVM. Country code for USA can be "US" in one application and map to "USA" in the other application.

DVMs are static in nature, though administrators can add additional maps as needed. Transactional business processes never update the Domain Value Maps (DVMs). Instead they only read from DVMs. They are stored in the XML files and cached in memory at runtime.

To Maintain Information within Domain Value Maps




	
1.


	
Open a browser and access the SOA Composer application ( http://host:port/soa/composer/)).











	
2.


	
On the SOA Composer, select Open from the drop-down list and select Open DVM.The list of all DVM files in the MDS repository is displayed.











	
3.


	
Select the relevant DVM you wish to maintain.











	
4.


	
Edit the selected DVM by clicking the Edit button in the top navigation bar for editing DVM.











	
5.


	
Once the DVM is edited, click Save in the navigation bar. This saves the DVM data for that session.











	
6.


	
Click Commit after updating each DVM.This saves the DVM data in the MDS repository.








The DVMs for the integration are described below. Each object refers to a valid object defined in Primavera P6 Enterprise Project Portfolio Management and a valid object defined in Oracle Utilities Work and Asset Management, as applicable:

Domain Value Code Details for the Integration Points




	
DVM


	
Integration Points


	
Description





	
WAMP6_EPS


	
Create Project and Retrieve Project Details


	
Maps the Primavera P6 Enterprise Project Portfolio Management EPS name stored in Oracle Utilities Work and Asset Management to the Primavera P6 Enterprise Project Portfolio Management EPS Object ID for that EPS in Primavera P6 Enterprise Project Portfolio Management and vice versa.





	
WAMP6_ProjectStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Project status to Primavera P6 Enterprise Project Portfolio Management Project status and vice versa.





	
WAMP6_ProjectUDF


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Project UDF Code to Primavera P6 Enterprise Project Portfolio Management Project UDF type Object ID and title.





	
WAMP6_SubprojectStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Sub Project status to Primavera P6 Enterprise Project Portfolio Management WBS status.





	
WAMP6_SubprojectUDF


	
WAMP6_SubprojectUDF


	
Maps the Oracle Utilities Work and Asset Management Sub Project UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type. object id and title





	
WAMP6_WorkOrderTaskStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order status to Primavera P6 Enterprise Project Portfolio Management. Management WBS status.





	
WAMP6_WorkOrderUDF


	
Create Project, Update Project., and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type.

 object id and title





	
WAMP6_WorkOrderTaskStatus


	
Create Project, Update Project, and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Work Order Task status to Primavera P6 Enterprise Project Portfolio Management. Management Activity status.







	
WAMP6_WorkOrderTaskUDF


	
Create Project, Update Project, and Retrieve Project details.


	
Maps the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity. UDF type Object ID and title.







	
WAMP6_Relationship


	
Create Project, Update Project and Retrieve Project details


	
Maps the Oracle Utilities Work and Asset Management Relationship Code to Primavera P6 Enterprise Project Portfolio Management Relationship type. Object ID.









	
3.4.3.1


	
WAMP6_EPS








This DVM transforms a Primavera P6 Enterprise Project Portfolio Management EPS name stored in Oracle Utilities Work and Asset Management to a Primavera P6 Enterprise Project Portfolio Management EPS Object ID.




	
WAM_EPSName


	
P6_EPSObjectID





	
This is the Primavera P6 Enterprise Project Portfolio Management EPS Name stored in the Oracle Utilities Work and Asset Management Project Management business rule.


	
This is the EPS Object ID corresponding to the EPS name stored in Oracle Utilities Work and Asset Management.









	
3.4.3.2


	
WAMP6_ProjectStatus








This DVM transforms the Oracle Utilities Work and Asset Management Project Status to Primavera P6 Enterprise Project Portfolio Management Project Status and vice versa.




	
WAM_ProjectStatus


	
P6_ProjectStatus





	
This is project status in Oracle Utilities Work and Asset Management.


	
This is the project status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.3


	
WAMP6_ProjectUDF








This DVM transforms the Oracle Utilities Work and Asset Management Project UDF Code to Primavera P6 Enterprise Project Portfolio Management Project UDF type Object ID and title.




	
WAM_ProjectUDFCode


	
P6_ProjectUDFTypeTitle


	
P6_ProjectUDFTypeObjectID





	
This is the project level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the project level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the project level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.4


	
WAMP6_SubprojectStatus








This DVM transforms the Oracle Utilities Work and Asset Management Subproject status to Primavera P6 Enterprise Project Portfolio Management Work Breakdown Structure (WBS) status and vice versa.




	
WAM_SubprojectStatus


	
P6_WBSStatus





	
This is sub project status in Oracle Utilities Work and Asset Management.


	
This is the WBS status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.5


	
WAMP6_SubprojectUDF








This DVM transforms the Oracle Utilities Work and Asset Management Subproject UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type Object ID and title.




	
WAM_SubprojectUDFCode


	
P6_WBSUDFTypeTitle


	
P6_WBSUDFTypeObjectID





	
 This is the sub project level UDF attribute name in Oracle Utilities Work and Asset Management. For example, ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.6


	
WAMP6_WorkOrderStatus








This DVM transforms the Oracle Utilities Work and Asset Management Work Order status to Primavera P6 Enterprise Project Portfolio Management Work Breakdown Structure (WBS) status and vice versa.




	
WAM_WorkOrderStatus


	
P6_WBSStatus





	
This is work order status in Oracle Utilities Work and Asset Management.


	
This is the WBS status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.7


	
WAMP6_WorkOrderUDF








This DVM transforms the Oracle Utilities Work and Asset Management Work Order UDF Code to Primavera P6 Enterprise Project Portfolio Management WBS UDF type Object ID and title.




	
WAM_WorkOrderUDFCode


	
P6_WBSUDFTypeTitle


	
P6_WBSUDFTypeObjectID





	
This is the work order level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the Object ID of the WBS level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.8


	
WAMP6_WorkOrderTaskStatus








This DVM transforms the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity UDF type Object ID and title.




	
WAM_WorkOrderTaskStatus


	
P6_ActivityStatus





	
This is work order task status in Oracle Utilities Work and Asset Management.


	
This is the Activity status in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.9


	
WAMP6_WorkOrderTaskUDF








This DVM transforms the Oracle Utilities Work and Asset Management Work Order Task UDF Code to Primavera P6 Enterprise Project Portfolio Management Activity UDF type object ID and title.




	
WAM_WorkOrderTaskUDFCode


	
P6_ActivityUDFTypeTitle


	
P6_ActivityUDFTypeObjectID





	
This is the work order task level UDF attribute name in Oracle Utilities Work and Asset Management e.g. ATTRIBUTE1, ATTRIBUTE2.


	
This is the title of the Activity level UDF type in Primavera P6 Enterprise Project Portfolio Management.


	
This is the object ID of the Activity level UDF type in Primavera P6 Enterprise Project Portfolio Management.









	
3.4.3.10


	
WAMP6_Relationship








This DVM transforms the Oracle Utilities Work and Asset Management Relationship Code to a Primavera P6 Enterprise Project Portfolio Management Relationship type object ID.




	
WAM_RelationshipCode


	
P6_RelationshipType





	
This is relationship code in Oracle Utilities Work and Asset Management.


	
This is the relationship type in Primavera P6 Enterprise Project Portfolio Management.












4 Monitoring and Troubleshooting

This section discusses in details the following:




	
•


	
Monitoring from Primavera P6 Enterprise Project Portfolio Management











	
•


	
Monitoring from Oracle Utilities Work and Asset Management











	
•


	
Monitoring from the Integration











	
•


	
Troubleshooting











	
4.1


	
Monitoring from Primavera P6 Enterprise Project Portfolio Management








Primavera P6 Enterprise Project Portfolio Management uses web service logs to manage error messages. Web service calls are logged in the Primavera P6 Enterprise Project Portfolio Management WebLogic server logs.

For more information about errors and notifications, see the Primavera P6 Enterprise Project Portfolio Management Web Services Programmer's Guide. Details for setting the log levels can be found under "Troubleshooting Primavera P6 Enterprise Project Portfolio Management Web Services", "About Logging", "Configuring the Logging Level". Details on how to enable or disable the logs can be found under "Troubleshooting Primavera P6 Enterprise Project Portfolio Management Web Services", "About Logging", "Setting Primaeval P6 Enterprise Project Portfolio Management Web Services Logging On and Off".




	
4.2


	
M onitoring from Oracle Utilities Work and Asset Management








Oracle Utilities Work and Asset Management processes errors in following ways:




	
•


	
Database Procedure - Errors are written to the Oracle Utilities Work and Asset Management Job Manager Log in the wifp_primavera_synch_resources batch process.











	
•


	
Inbound messages - Errors are logged in xt_web_services_inbound_log. Detailed errors are logged to the Oracle Utilities Work and Asset Management OC4J instance in the redirected output/errors log (default pathname is <oracle-home>\opmn\logs\OC4J~OC4J_<instance name>~default_island~1).











	
•


	
Outbound messages - Errors are logged in the xt_web_services_outbound_log table as well as in the Job Manager Log module. Detailed errors are logged in the same way as inbound errors.











	
•


	
Web Services Gateway Business Rule - The Log Level column in the business rule can be used to set which messages are written to error logs. Configure the rule keys with the appropriate setting for the amount of information you want to have written to the logs.








For more information, refer to the Oracle Utilities Work and Asset Management Configuration Guide.




	
4.3


	
Monitoring from the Integration








The section describes the utilities used to monitor the integration, use any of the following:




	
•


	
Monitoring using WebLogic SOA Enterprise Manager











	
•


	
Monitoring using the WebLogic Logs











	
•


	
Data Purge











	
4.3.1


	
Monitoring using WebLogic SOA Enterprise Manager








Perform the following steps to monitor using the WebLogic SOA Enterprise Manager:

 Monitor the Integration Layer from the WebLogic SOA Enterprise Manager




	
1.


	
Log in to the WebLogic SOA Server Enterprise Manager, and then navigate to SOA > SOA-Infra > WAM-Primavera.All composite processes deployed for integration are available under the partition P6-WAM.











	
2.


	
Select the appropriate process to list all the instances for the processes sorted by time of execution.The instances also have the request ID as part of the display name.











	
•


	
OUWAMP6UpdateCraftRatesEBF has the Oracle Utilities Work and Asset Management Plant and Craft ID combination in the display name











	
•


	
OUWAMP6CreateProjectEBF has the Oracle Utilities Work and Asset Management project ID in the display name











	
•


	
OUWAMP6UpdateProjectEBF has the Oracle Utilities Work and Asset Management project ID in the display name











	
•


	
OUWAMP6RetrieveProjectEBF has the Primavera P6 Enterprise Project Portfolio Management Project Object ID in the display name











	
3.


	
Click the appropriate process instance and it will display the flow for the process.The composite flow lists all activities in the process instance.











	
4.3.2


	
Monitoring using the WebLogic Logs








Log in to the machine where SOA server is installed. The SOA logs are stored in: <WebLogic installation folder>/user_projects/domains/<SOA Domain name>/servers/<SOA Server name>/logs

For example: /slot/ems1234/oracle/Middleware/user_projects/domains/soa_domain/servers/soa_server1/logs




	
4.3.3


	
Data Purge








To maintain maximum system integrity, the Oracle Fusion Middleware database should be purged periodically.

For information about how to complete this task, refer to the note 815896.1 on https://support.oracle.com




	
4.4


	
Troubleshooting








At times, the integration might experience errors or issues with connection, processing, or sending or receiving messages. Following are the common scenarios which help you to troubleshoot error, if any, and find possible solutions:




	
Possible Error Scenario


	
Resolution





	
Oracle Utilities Work and Asset Management is unable to connect to the integration layer.


	



	
•


	
Verify the settings in the Web Services Gateway business rule.











	
•


	
Verify whether or not the integration layer is running and to SOA composite is deployed and accepting requests.












	
The integration is unable to connect to Primavera P6 Enterprise Project Portfolio Management


	
Perform the following steps:




	
1.


	
Check the SOA composite process to find out where the failure occurred.











	
2.


	
Verify whether or not the Primavera P6 Enterprise Project Portfolio Management credentials are properly configured in the integration layer by logging into the enterprise manager console and navigating to Weblogic domain > <Domain Name>.











	
3.


	
Right click on the <Domain Name> and select Security > Credentials











	
4.


	
Under the credential map oracle.wsm.security, select the key WAM-Primavera. Verify whether or not the Primavera P6 Enterprise Project Portfolio Management user password is correct.











	
5.


	
Verify whether the Primavera P6 Enterprise Project Portfolio Management environment is up and running.
















	
4.4.1


	
Error Codes








The following error codes can be managed as Service Configuration . The descriptions below provide additional details about possible resolutions for these errors.




	
Error Code


	
Description/Resolution





	
1000


	
A technical error in the integration layer. This description is configurable in the middleware.





	
1001


	
A create failure when importing in Primavera P6 Enterprise Project Portfolio Management.




	
•


	
Verify that EPS is specified on the DVM. EPS must be specified to create a new project through import.











	
•


	
Field " Name" in WBS may not be of zero length.An error is triggered when the integration is unable to invoke set Name on the WBS business object.











	
•


	
A project specific object activity may be out of order.











	
•


	
There may be an invalid value for field PlannedStartDate: YYYY-MM-DD HH:MM:SS











	
•


	
The PlannedDuration field may not be set to null.











	
•


	
The XML file path parameter may not be null.












	
1002


	
A RETRIEVE failure (Export in Primavera P6 Enterprise Project Portfolio Management) when invoking Create Project.





	
1003


	
An UPDATE failure (Import in Primavera P6 Enterprise Project Portfolio Management)




	
•


	
The DataDate may not be after the ProjectPlannedStart date.











	
•


	
The Field ObjectID may not be set to null.











	
•


	
The system may not be able to lock the project at the requested access level.











	
•


	
A project specific object WBS may appear out of order.











	
•


	
There could be an invalid value for theMustFinishByDate field: YYYY-MM-DD HH:MM:SS











	
•


	
The system may not be able to find the project object with ID = ####












	
1004


	
A RETRIEVE failure (Export in Primavera P6 Enterprise Project Portfolio Management) when invoking Update Project.





	
1005


	
A RETRIEVE failure (Export in Primavera P6 Enterprise Project Portfolio Management) when invoking Retrieve Project. The integration is unable to load project with ID of ####.





	
1006


	
 Plant/Craft combination does not exist when invoking Create and Update project.





	
1007


	
Technical Error coming from Primavera P6 Enterprise Project Portfolio Management when invoking the Craft Rates synchronization.





	
5001


	
Primavera P6 Resource service invocation error for craft rate service. This error comes from Primavera P6 Enterprise Project Portfolio Management.














5 Customization Options

This chapter provides information on the various methods that can be used to extend or customize the integration.




	
5.1


	
User Defined Fields








Oracle Utilities Work and Asset Management passes user defined fields at Project, Subproject, Work Order and Work Order task levels. These fields can be stored as user defined fields in Primavera P6 Enterprise Project Portfolio Management at Project, WBS for subproject, WBS for Work Order and Activity level. The UDF mapping is as shown in the table below:




	
Oracle Utilities Work and Asset Management UDF Object


	
Primavera P6 Enterprise Project Portfolio Management UDF Object





	
Project


	
Project





	
Sub Project


	
WBS





	
Work Order


	
WBS





	
Work Order Task


	
Activity






To pass the User defined fields from Oracle Utilities Work and Asset Management and store them in Primavera P6 Enterprise Project Portfolio Management, perform the following steps:




	
1.


	
Set the UDF values in Oracle Utilities Work and Asset Management in the outgoing request to integration. Refer to the Oracle Utilities Work and Asset Management Configuration Guide for complete details.











	
2.


	
In Primavera P6 Enterprise Project Portfolio Management, create the UDF Types at the Project level > WBS and Activity levels. The UDF Types can be created only for the attributes which are passed from Oracle Utilities Work and Asset Management as described in UDF Type - Project , UDF Type - Sub Project (WBS) , UDF Type - Work Order (WBS) , and UDF Type - Work Order Task (Activity) .











	
3.


	
In the integration layer set the Oracle Utilities Work and Asset Management attribute name which are ATTRIBUTE1 to ATTRIBUTE10, the Primavera P6 Enterprise Project Portfolio Management UDF Type title and the Primavera P6 Enterprise Project Portfolio Management UDF Type Object ID in the appropriate UDF DVM. The Data Value Maps be to setup are WAMP6_ProjectUDF , WAMP6_SubprojectUDF , WAMP6_WorkOrderUDF and WAMP6_WorkOrderTaskUDF .











	
4.


	
After the setup is done and Oracle Utilities Work and Asset Management passes an UDF field value integration layer picks up the DVM values for P6 UDF Type title and UDF Type Object ID for the appropriate attribute and sets it in the P6 request.








"The UDF values coming from Oracle Utilities Work and Asset Management are associated to the appropriate UDF type in Primavera P6 Enterprise Project Portfolio Management.




	
5.2


	
Extension Methods








The integration process allows extensibility of transaction messages using the following methods:




	
1.


	
Pre-Transformation Extension Point











	
2.


	
Post-Transformation Extension Point











	
3.


	
Custom-Transformations











	
4.


	
P6 Enterprise Project Portfolio to Oracle Utilities Work and Asset Management to Primavera Transformations











	
5.


	
Post-Transformation Extension Point











	
6.


	
Custom-Transformations








The following diagram depicts the integration process extensibility:

 [image: ]

Extensibility Options




	
5.2.1


	
Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Transformations











	
5.2.1.1


	
Pre-Transformation Extension Point








The pre transformation extension point is invoked before the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation is executed. This transformation helps in enhancing the Oracle Utilities Work and Asset Management request xml coming as an input to the integration process.

The integration layer defines an external call from the Pre transformation extension point which accepts the Oracle Utilities Work and Asset Management request xml as input and gives the Oracle Utilities Work and Asset Management request xml as output. Integration layer points an abstract WSDL and can be plugged in by a concrete WSDL by the implementation team.

This helps the implementation to invoke any external web service and transform the Oracle Utilities Work and Asset Management request message.




	
5.2.1.2


	
Post-Transformation Extension Point








The post transformation extension point is invoked after the Oracle Utilities Work and Asset Management to Primavera P6 Enterprise Project Portfolio Management request transformation is executed. This transformation helps in transforming the Primavera P6 Enterprise Project Portfolio Management request message.

The integration layer defines an external call from the Post transformation extension point which accepts the Primavera P6 Enterprise Project Portfolio Management request message as input and gives the same message back as output. Integration layer points to an abstract WSDL and can be plugged in by a concrete WSDL by the implementation team.

This helps the implementation to invoke any external web service and transform the Primavera P6 Enterprise Project Portfolio Management request message.




	
5.2.1.3


	
Custom-Transformations








The custom transformations are used to add data to the message and are invoked from the main transformation. The request transformation invokes custom transformation.

Empty custom transformation is shipped with the product.

The implementation team can add additional mappings in the custom transformations. and map them using the custom transformations. Using custom transformations enables the implementation to pass additional data in the message.




	
5.2.2


	
P6 Enterprise Project Portfolio to Oracle Utilities Work and Asset Management to Primavera Transformations











	
5.2.2.1


	
Pre-Transformation Extension Point








The pre transformation extension point is invoked before the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation is executed. This transformation will help in enhancing the Primavera P6 Enterprise Project Portfolio Management response message coming as a response to the integration process.

The integration layer will define an external call from the Pre transformation extension point which accepts the Primavera P6 Enterprise Project Portfolio Management response message as input and gives the Primavera P6 Enterprise Project Portfolio Management response message as output. Integration layer will point an abstract WSDL and can be plugged in by a concrete WSDL by the implementation team.

This helps the implementation to invoke any external web service and transform the Primavera P6 Enterprise Project Portfolio Management response message.




	
5.2.2.2


	
Post-Transformation Extension Point








The post transformation extension point is invoked after the Primavera P6 Enterprise Project Portfolio Management to Oracle Utilities Work and Asset Management response transformation is executed. This transformation helps in transforming the Oracle Utilities Work and Asset Management response message.

The integration layer defines an external call from the Post transformation extension point which accepts the Oracle Utilities Work and Asset Management response message as input and gives the same message back as output. Integration layer points to an abstract WSDL and can be plugged in by a concrete WSDL by the implementation team.

This helps the implementation to invoke any external web service and transform the Oracle Utilities Work and Asset Management response message.




	
5.2.2.3


	
Custom-Transformations








The custom transformations are used to add data to and the message and are invoked from the main transformation. The response transformation invokes custom transformation.

Empty custom transformation is shipped with the product.

The implementation team can add additional mappings in the custom transformations. Using custom transformations will enable the implementation to pass additional data in the message.




	
5.2.3


	
Steps to Implement Extension Points








To implement extension points, perform the following steps:




	
1.


	
Each process in the integration has a pre and post transformation extension point which can be used to invoke Web services and transform the payload.











	
2.


	
The desired extension point can be triggered from the process by enabling it using the ConfigurationProperties.xml pre and post transformation extension flags as described in section Configure Configuration Properties .











	
3.


	
Each process has its own concrete wsdl which is used to read the endpoint location for the extension service. These concrete wsdl files are located in MDS under the following directories:











	
•


	
/apps/WAM-Primavera/AIAMetaData/AIAComponents/ExtensionServiceLibrary Update the concrete wsdl file to soap address location details for the extension service to be called and move the concrete wsdl file to MDS.











	
4.


	
To move the concrete wsdl to MDS, update the appropriate wsdl in the product install home. The directories to put the concrete wsdl in product install home are the following:








$PRODUCT_HOME/MDS-Artifacts/WAM-Primavera/AIAMetaData/AIAComponents/ExtensionServiceLibrary Then deploy the concrete wsdls to MDS by running the ant deploy command for Deploying MDS folder.For more information about the command to use to deploying to MDS, see the Oracle Utilities Work and Asset Management Integration to Primavera P6 Enterprise Project Portfolio Management Installation Guide - Deploying MDS Folder.




	
5.


	
After deploying the files to MDS, restart the SOA server.











	
6.


	
After restarting the SOA server, the extension point invokes the Web service in the concrete WSDL. For example: To enable the extension points for OUWAMP6CreateProjectExtensionConcrete, change the soap address > location and set the URL of the extension service.








<service name=" OUWAMPrimaveraCreateProjectExtensionService">

 <port name=" OUWAMPrimaveraCreateProjectExtensionServicePort"

 binding="tns:OUWAMPrimaveraCreateProjectExtensionServiceBinding">

 <soap:address location="<URL of the extension service>"/>

 </port>

 </service>

 Note: The binding and service can be added easily using the Oracle Jdeveloper 11g.




	
5.2.4


	
Steps to Implement Custom Transformations








To implement custom transformations, perform the following steps:




	
1.


	
Each process has a main transformation which invokes custom templates. Each main transformation file has a corresponding custom XSL and custom templates are defined in the custom XSL.











	
2.


	
These custom templates are invoked from the main message.











	
3.


	
The custom XSL can be modified to add additional transformation to map additional fields in the message.











	
4.


	
The custom XSL files are located in product install home under the directory and end with "_Custom" P6-WAM/services/industry/Utilities/EBF/<Process Name>/xsl











	
5.


	
After updating the custom XSL files in the product install home, update MDS using the ant deploy command for Deploying MDS folder.








For complete information on command values to use while deploying MDS, refer to the Oracle Utilities Work and Asset Management Integration to Primavera P6 Enterprise Project Portfolio Management Installation Guide -Deploying MDS Folder.




	
6.


	
After deploying the files to MDS, restart the SOA server.











	
7.


	
After restarting the SOA server, the changes to the custom xsl is now reflected in the integration.












6 Data Mapping

This section provides mapping details for each integration point. They are as follows:




	
•


	
Create Project











	
•


	
Update Project











	
•


	
Retrieve Project Details












Create Project

This section provides data mapping details for the following:




	
•


	
Create Project Request











	
•


	
Create Project Response












Create Project Request

Create Project Request Mapping details for each integration point are as shown in the table below:




	
Oracle Utilities Work and Asset Management Mapping


	
Primavera P6 Enterprise Project Portfolio Management Mapping


	
DVM Mapping


	



	






	
Element Name


	
Parent Element


	
Type


	
 Element Name


	
Parent Element


	
Type


	
DVM


	
WAM Column


	
Primavera Column





	



	



	



	



	



	



	



	



	






	
Project


	



	
OutermostTag


	
CreateNewProject


	



	
OutermostTag


	



	



	






	



	



	



	
DefaultGlobalImportOption


	
CreateNewProject


	
Field


	



	



	






	



	



	



	
DefaultProjectSpecificImportOption


	
CreateNewProject


	
Field


	



	



	






	



	



	



	
EPSObjectID


	
CreateNewProject


	
Field


	



	



	






	



	



	



	
FileType


	
CreateNewProject


	
Field


	



	



	






	



	



	



	
IgnoreGUID


	
CreateNewProject


	
Field


	



	



	






	



	



	



	
IgnoreSequenceNumber


	
CreateNewProject


	
Field


	



	



	






	



	



	



	
LogLevel


	
CreateNewProject


	
Field


	



	



	






	



	



	



	
 ProjectData


	
CreateNewProject


	
Field


	
ODM_MDM_MO


	
ODM_MO


	
MDM_MO





	



	



	



	
APIBusinessObjects


	
Project


	
Group


	



	



	






	



	



	



	
UDFType


	
APIBusinessObjects


	
List


	



	



	






	



	



	



	
ObjectID


	
UDFType


	
Field


	



	



	






	



	



	



	
SubjectArea


	
UDFType


	
Field


	



	



	






	
pkValue4


	
sendDetails


	
Field


	
Title


	
UDFType


	
Field


	



	



	






	
pkValue5


	
sendDetails


	
Field


	
DataType


	
UDFType


	
Field


	



	



	






	



	



	



	
UDFType


	
APIBusinessObjects


	
Group


	



	



	






	



	



	



	
ObjectID


	
UDFType


	
Field


	



	



	






	



	



	



	
SubjectArea


	
UDFType




	
Field


	



	



	






	



	



	



	
Title


	
UDFType


	
Field


	



	



	






	



	



	



	
DataType


	
UDFType


	
Field


	



	



	






	
Labor


	
WorkOrderTask


	
List


	
Resource


	
APIBusinessObjects
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BusinessObjectOptions


	
CreateNewProject


	
Group


	



	



	






	



	



	



	
Global


	
BusinessObjectOptions


	
Group


	



	



	






	



	



	



	
Resource


	
Global


	
Group


	



	



	






	



	



	



	
ImportOption


	
Resource


	
Field


	



	



	






	



	



	



	
UDFType


	
Global


	
Group


	



	



	






	



	



	



	
ImportOption


	
Resource


	



	



	



	











Create Project Response

Create Project Response Mapping details are similar to the Retrieve Project Details. For Create Project Response Mapping details, refer to Retrieve Project Details Response mapping details.





Update Project

This section provides data mapping details for the following:




	
•


	
Update Project Request











	
•


	
Update Project Response












Update Project Request

Update Project Request Mapping for each integration point is shown in the table below:




	
Oracle Utilities Work and Asset Management Message


	
Primavera P6 Enterprise Project Portfolio Management Message


	
DVM Mapping





	
Element Name


	
Parent Element


	
Type


	
 Element Name


	
Parent Element


	
Type


	
DVM


	
WAM Column


	
Primavera

Column





	
Project


	
OutermostTag


	
UpdateExistingProject


	



	
OutermostTag




	



	






	



	



	



	
DefaultGlobalImportOption




	
UpdateExistingProject




	
Field


	



	



	






	



	



	



	
DefaultProjectSpecificImportOption


	
UpdateExistingProject




	
Field


	



	



	






	



	



	



	
ProjectObjectID


	
UpdateExistingProject




	
Field


	



	



	






	



	



	



	
FileType


	
UpdateExistingProject




	
Field


	



	



	






	



	



	



	
IgnoreGUID


	
UpdateExistingProject




	
Field


	



	



	






	



	



	



	
IgnoreSequenceNumber


	
UpdateExistingProject




	
Field


	



	



	






	



	



	



	
LogLevel


	
UpdateExistingProject




	
Field


	



	



	






	



	



	



	
ProjectData


	
UpdateExistingProject




	
Field


	



	



	






	



	



	



	
APIBusinessObjects


	
ProjectData


	
Group


	



	



	






	



	



	



	
UDFType


	
APIBusinessObjects


	
List


	



	



	






	



	



	



	
ObjectID


	
UDFType


	
Field


	



	



	






	



	



	



	
SubjectArea


	
UDFType


	
Field


	



	



	






	



	



	



	
Title


	
UDFType


	
Field


	



	



	






	



	



	



	
DataType


	
UDFType


	
Field


	



	



	






	



	



	



	
UDFType


	
APIBusinessObjects


	
Group


	



	



	






	



	



	



	
ObjectID


	
UDFType


	
Field


	



	



	






	



	



	



	
SubjectArea


	
UDFType


	
Field


	



	



	






	



	



	



	
Title


	
UDFType


	
Field


	



	



	






	



	



	



	
DataType


	
UDFType


	
Field


	



	



	






	
Labor


	
WorkOrderTask


	
List


	
Resource


	
APIBusinessObjects


	
List


	



	



	






	
PLANT


	
Project


	
Field


	
ID


	
Resource


	
Field


	



	



	






	
CRAFT


	
Labor


	
Field


	
ID


	
Resource


	
Field


	



	



	






	



	



	



	
ObjectID


	
Resource


	
Field


	



	



	






	



	



	



	
Project


	
APIBusinessObjects


	
Group


	



	



	






	
PLANT


	
Project


	
Field


	



	



	



	



	



	






	
PROJECT_ID


	
Project


	
Field


	
ID


	
Project


	
Field


	



	



	






	
PROJECT_STATUS


	
Project


	
Field


	
Status


	
Project


	
Field


	
WAMP6_ProjectStatus


	
WAM_ProjectStatus


	
P6_ProjectStatus





	
PROJECT_TITLE


	
Project


	
Field


	



	



	



	



	



	






	
PROJECT_SUPERVISOR


	
Project


	
Field


	



	



	



	



	



	






	
ESTIMATED_START_DATE


	
Project


	
Field


	
AnticipatedStartDate


	
Project


	
Field


	



	



	






	
ESTIMATED_COMPLETE_DATE


	
Project


	
Field


	
AnticipatedFinishDate


	
Project


	
Field


	



	



	






	
ACTUAL_START_DATE


	
Project


	
Field


	
PlannedStartDate


	
Project


	
Field


	



	



	






	
ACTUAL_COMPLETE_DATE


	
Project


	
Field


	
MustFinishByDate


	
Project


	
Field


	



	



	






	
LAST_UPDATE_DATE


	
Project


	
Field


	



	



	



	



	



	






	
LAST_UPDATE_USER


	
Project


	
Field


	



	



	



	



	



	






	
CREATE_DATE


	
Project


	
Field


	



	



	



	



	



	






	
CREATED_BY


	
Project


	
Field


	



	



	



	



	



	






	



	



	



	
UDF


	
Project


	
List


	



	



	






	



	



	



	
TypeObjectID


	
UDF


	
Field


	
WAMP6_ProjectUDF


	
WAM_ProjectUDFCode


	
P6_ProjectUDFTypeObjectID





	
ATTRIBUTE1


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE2


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE3


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE4


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE5


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE6


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE7


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE8


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE9


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE10


	
Project


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
PROJECT_STATUS_DATE


	
Project


	
Field


	
DataDate


	
Project


	
Field


	



	



	






	
PROJECT_MANAGER


	
Project


	
Field


	



	



	



	



	



	






	
PROJECT_LIMIT


	
Project


	
Field


	
OriginalBudget


	
Project


	
Field


	



	



	






	
P6_EPS_NAME


	
Project


	
Field


	
ParentEPSObjectID


	
Project


	
Field


	



	



	






	
PROJECT_MANAGEMENT_TITLE


	
Project


	
Field


	
Name


	
Project


	
Field


	



	



	






	
DESCRIPTION


	
Project


	
Field


	
Descriptoin


	
Project


	
Field


	



	



	






	
P6_ID


	
Project


	
Field


	
ObjectID


	
Project


	
Field


	



	



	






	
SubProject


	
Project


	
List


	
WBS


	
Project


	
List


	



	



	






	
PROJECT_ID


	
Project


	
Field


	
ProjectObjectID


	
WBS


	
Field


	



	



	






	
SUBPROJECT_ID


	
Subproject


	
Field


	
Code


	
WBS


	
Field


	



	



	






	
SUBPROJECT_STATUS


	
Subproject


	
Field


	
Status


	
WBS


	
Field


	
WAMP6_Subprojectstatus


	
P6_WBSStatus


	






	
SUBPROJECT_DESC


	
Subproject


	
Field


	
Name


	
WBS


	
Field


	



	



	






	
ESTIMATED_START_DATE


	
Subproject


	
Field


	
AnticipatedStartDate


	
WBS


	
Field


	



	



	






	
ESTIMATED_COMPLETE_DATE


	
Subproject


	
Field


	
AnticipatedFinishDate


	
WBS


	
Field


	



	



	






	
ACTUAL_START_DATE


	
Subproject


	
Field


	



	



	



	



	



	






	
ACTUAL_COMPLETE_DATE


	
Subproject


	
Field


	



	



	



	



	



	






	
ACCOUNT_NO


	
Subproject


	
Field


	



	



	



	



	



	






	
PROJECT_TYPE


	
Subproject


	
Field


	



	



	



	



	



	






	
CREATED_BY


	
Subproject


	
Field


	



	



	



	



	



	






	
CREATE_DATE


	
Subproject


	
Field


	



	



	



	



	



	






	
LAST_UPDATE_USER


	
Subproject


	
Field


	



	



	



	



	



	






	
LAST_UPDATE_DATE


	
Subproject


	
Field


	



	



	



	



	



	






	
SUPERVISOR_NAME


	
Subproject


	
Field


	



	



	



	



	



	






	
BUDGET_AMOUNT


	
Subproject


	
Field


	
OriginalBudget


	
WBS


	
Field


	



	



	






	



	
Subproject


	
Field


	
UDF


	
WBS


	
List


	



	



	






	



	
Subproject


	
Field


	
TypeObjectID


	
UDF


	
Field


	
WAMP6_SubprojectUDF


	
WAM_SubprojectUDFCode


	
P6_WBSUDFTypeObjectID





	
ATTRIBUTE1


	
Subproject


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE2


	
Subproject


	
Field


	



	



	



	



	



	






	
ATTRIBUTE3


	
Subproject


	
Field


	



	



	



	



	



	






	
ATTRIBUTE4


	
Subproject


	
Field


	



	



	



	



	



	






	
ATTRIBUTE5


	
Subproject


	
Field


	



	



	



	



	



	






	
ATTRIBUTE6


	
Subproject


	
Field


	



	



	



	



	



	






	
ATTRIBUTE7


	
Subproject


	
Field


	



	



	



	



	



	






	
ATTRIBUTE8


	
Subproject


	
Field


	



	



	



	



	



	






	
ATTRIBUTE9


	
Subproject


	
Field


	



	



	



	



	



	






	
ATTRIBUTE10


	
Subproject


	
Field


	



	



	



	



	



	






	
REQUESTOR


	
Subproject


	
Field


	



	



	



	



	



	






	
REQUEST_DATE


	
Subproject


	
Field


	



	



	



	



	



	






	
REQUESTOR_DEPARTMENT


	
Subproject


	
Field


	



	



	



	



	



	






	
REQUESTOR_PHONE_NO


	
Subproject


	
Field


	



	



	



	



	



	






	
REQUIRED_DATE


	
Subproject


	
Field


	



	



	



	



	



	






	
P6_WBS_ID


	
Subproject


	
Field


	
ObjectID


	
WBS


	
Field


	



	



	






	
WorkOrder


	
Subproject


	
List


	
WBS


	
 Project


	
List


	



	



	






	
PROJECT_ID


	
Subproject


	
Field


	
ProjectObjectID


	
WBS


	
Field


	



	



	






	
Work_Order_NO


	
WorkOrder


	
Field


	
Code


	
WBS


	
Field


	



	



	






	
WORK_TYPE


	
WorkOrder


	
Field


	



	



	



	



	



	






	
WORK_DESC


	
WorkOrder


	
Field


	
Name


	
WBS


	
Field


	



	



	






	
ACCOUNT_NO


	
WorkOrder


	
Field


	



	



	



	



	



	






	
WORK_STATUS


	
WorkOrder


	
Field


	
Status


	
WBS


	
Field


	
WAMP6_ WorkOrderStatus


	
WAM_WorkOrderStatus


	
P6_WBSStatus





	
WORK_STATUS_DATE


	
WorkOrder


	
Field


	



	



	



	



	



	






	
WORK_CLASS


	
WorkOrder


	
Field


	



	



	



	



	



	






	
WORK_CATEGORY


	
WorkOrder


	
Field


	



	



	



	



	



	






	
REQUESTOR_NAME


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ASSET_RECORD_TYPE


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ASSET_ID


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ASSET_DESC


	
WorkOrder


	
Field


	



	



	



	



	



	






	
COMPONENT_ID


	
WorkOrder


	
Field


	



	



	



	



	



	






	
COMPONENT_ID_DESC


	
WorkOrder


	
Field


	



	



	



	



	



	






	
PROCESS_NO


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ACCOUNT_NO


	
WorkOrder


	
Field


	



	



	



	



	



	






	
TASK_PRIORITY_DEFAULT


	
WorkOrder


	
Field


	



	



	



	



	



	






	
PLANNER


	
WorkOrder


	
Field


	



	



	



	



	



	






	
LEAD_CREW


	
WorkOrder


	
Field


	



	



	



	



	



	






	
DEFICIENCY_TAG


	
WorkOrder


	
Field


	



	



	



	



	



	






	
PLANNED_TOTAL_AMOUNT


	
WorkOrder


	
Field


	
OriginalBudget


	
WBS


	
Field


	



	



	






	
APPROVED_AMOUNT


	
WorkOrder


	
Field


	
CurrentBudget


	
WBS


	
Field


	



	



	






	
INSPECTION_IND


	
WorkOrder


	
Field


	



	



	



	



	



	






	
CLOSE_WO_IND


	
WorkOrder


	
Field


	



	



	



	



	



	






	



	



	



	
UDF


	
WBS


	
List


	



	



	






	



	



	



	
TypeObjectID


	
UDF


	
Field


	
WAMP6_WorkOrderUDF


	
WAM_WorkOrderUDFCode


	
P6_WBSUDFTypeObjectID





	
ATTRIBUTE1


	
WorkOrder


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE2


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ATTRIBUTE3


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ATTRIBUTE4


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ATTRIBUTE5


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ATTRIBUTE6


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ATTRIBUTE7


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ATTRIBUTE8


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ATTRIBUTE9


	
WorkOrder


	
Field


	



	



	



	



	



	






	
ATTRIBUTE10


	
WorkOrder


	
Field


	



	



	



	



	



	






	
P6_WBS_ID


	
WorkOrder


	
Field


	
ObjectID


	
WBS


	
Field


	



	



	






	
WorkOrderTask


	
WorkOrder


	
List


	
Activity


	
Project


	
List


	



	



	






	
Work_Order_Task_NO


	
WorkOrder


	
Field


	
ID


	
Activity


	
Field


	



	



	






	



	



	



	
WBSCode


	
Activity


	
Field


	



	



	






	
PROJECT_ID


	
Project


	
Field


	
ProjectObjectID


	
Activity


	
Field


	



	



	






	
TASK_SEQUENCE_NUMBER


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
TASK_STATUS


	
WorkOrderTask


	
Field


	
Status


	
Activity


	
Field


	
WAMP6_WorkOrderTaskStatus


	
WAM_WorkOrderTaskStatus


	
P6_ActivityStatus





	
TASK_STATUS_DATE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
TASK_DESC


	
WorkOrderTask


	
Field


	
Name


	
Activity


	
Field


	



	



	






	
WORK_CLASS


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
WORK_CATEGORY


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ASSET_RECORD_TYPE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ASSET_ID


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ASSET_DESC


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
COMPONENT_ID


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
COMPONENT_ID_DESC


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
PROCESS_NO


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
PLANNER


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
DEPARTMENT


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
AREA


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ACCOUNT_NO


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
VEHICLE_SYSTEM_CODE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
VEHICLE_ASSEMBLY_CODE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
VEHICLE_COMPONENT_CODE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
SAFETY_CRITICAL_IND


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ISO_IND


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
HEALTH_IND


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ENVIRONMENTAL_IND


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
RUN_TO_FAILURE_IND


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
TASK_PHASE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
HELD_FOR_PARTS_IND


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
TASK_REQUIRED_DATE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
PERCENT_COMPLETE


	
WorkOrderTask


	
Field


	
PhysicalPercentComplete


	
Activity


	
Field


	



	



	






	



	



	



	
PercentCompleteType


	
Activity


	
Field


	



	



	






	
DOWNTIME_IND


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
DOWNTIME_TYPE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
DOWNTIME_HOURS


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
TASK_PRIORITY_TOTAL


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
CRITICALITY


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
TASK_PRIORITY


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
TASK_PRIORITY_ADJUSTMENT


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
CREW


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
BACKLOG_GROUP


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
SHOP


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
PM_ROUTE_NO


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
SCHEDULE_DATE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ASSIGNED_TO_NAME


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
WORK_LOCATION


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
TRAVEL_TIME


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
WORK_TRIP


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
JOB_CODE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
JOB_REASON_CODE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
JOB_ACTION_CODE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
METER_READING_DATE


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
METER_READING_CURRENT


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
METER_UNITS


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
METER_LTD


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
REPORT_CODE1


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
REPORT_CODE2


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
REPORT_CODE3


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
REPORT_CODE4


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
REPORT_CODES


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
WORK_REQUEST_NO


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
SERVICE_REQUEST_NO


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
DEFICIENCY_TAG


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
WBS


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ESTIMATED_DURATION


	
WorkOrderTask


	
Field


	
PlannedDuration


	
Activity


	
Field


	



	



	






	
TASK_ESTIMATED_START_DATE


	
WorkOrderTask


	
Field


	
PlannedStartDate


	
Activity


	
Field


	



	



	






	
TASK_ESTIMATED_FINISH_DATE


	
WorkOrderTask


	
Field


	
PlannedFinishDate


	
Activity


	
Field


	



	



	






	
ACTUAL_DURATION


	
WorkOrderTask


	
Field


	
ActualDuration


	
Activity


	
Field


	



	



	






	
ACTUAL_START_DATE


	
WorkOrderTask


	
Field


	
ActualStartDate


	
Activity


	
Field


	



	



	






	
ACTUAL_FINISH_DATE


	
WorkOrderTask


	
Field


	
ActualFinishDate


	
Activity


	
Field


	



	



	






	



	



	



	
UDF


	
Activity


	
List


	



	



	






	



	



	



	
TypeObjectID


	
UDF


	
Field


	
WAMP6WorkOrderTASKUDF


	
WAM_WoorkOrderTaskUDFCode


	
P6_ActivityUDFTypeObjectID





	
ATTRIBUTE1


	
WorkOrderTask


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
ATTRIBUTE2


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ATTRIBUTE3


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ATTRIBUTE4


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ATTRIBUTE5


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ATTRIBUTE6


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ATTRIBUTE7


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ATTRIBUTE8


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ATTRIBUTE9


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
ATTRIBUTE10


	
WorkOrderTask


	
Field


	



	



	



	



	



	






	
P6_ACTIVITY_ID


	
WorkOrderTask


	
Field


	
ObjectID


	
Activity


	
Field


	



	



	






	
Labor


	
WorkOrderTask


	
List


	
ResourceAssignment


	
Project


	
List


	



	



	






	
PROJECT_ID


	
Project


	
Field


	
ProjectObjectID


	
ResourceAssignment


	
Field


	



	



	






	



	



	



	
ResourceObjectID


	
ResourceAssignment


	
Field


	



	



	






	
CRAFT


	
Labor


	
Field


	



	



	



	



	



	






	
CRAFTSMEN_QUANTITY


	
Labor


	
Field


	
PlannedUnitsPerTime


	
ResourceAssignment


	
Field


	



	



	






	
LABOR_DURATION


	
Labor


	
Field


	



	



	



	



	



	






	
EXPENSE_CODE


	
Labor


	
Field


	



	



	



	



	



	






	
PREMIUM_EXPENSE_CODE


	
Labor


	
Field


	



	



	



	



	



	






	
ORIGINAL_ESTIMATE_HOURS


	
Labor


	
Field


	
PlannedUnits


	
ResourceAssignment


	
Field


	



	



	






	
ORIGINAL_ESTIMATE_AMOUNT


	
Labor


	
Field


	
PlannedCost


	
ResourceAssignment


	
Field


	



	



	






	
REVISED_ESTIMATE_HOURS


	
Labor


	
Field


	
ActualThisPeriodUnits


	
ResourceAssignment


	
Field


	



	



	






	
REVISED_ESTIMATE_AMOUNT


	
Labor


	
Field


	
ActualThisPeriodCost


	
ResourceAssignment


	
Field


	



	



	






	
EXTERNAL_COMMITTED_HOURS


	
Labor


	
Field


	



	



	



	



	



	






	
EXTERNAL_COMMITTED_AMOUNT


	
Labor


	
Field


	



	



	



	



	



	






	
ACTUAL_HOURS


	
Labor


	
Field


	
ActualRegularUnits


	
ResourceAssignment


	
Field


	



	



	






	
ACTUAL_AMOUNT


	
Labor


	
Field


	
ActualRegularCost


	
ResourceAssignment


	
Field


	



	



	






	
ACTUAL_PREMIUM_HOURS


	
Labor


	
Field


	
ActualOvertimeUnits


	
ResourceAssignment


	
Field


	



	



	






	
ACTUAL_START_DATE


	
WorkOrderTask


	
Field


	
ActualStartDate


	
ResourceAssignment


	
Field


	



	



	






	
ACTUAL_FINISH_DATE


	
WorkOrderTask


	
Field


	
ActualFinishDate


	
ResourceAssignment


	
Field


	



	



	






	
ACTUAL_PREMIUM_AMOUNT


	
Labor


	
Field


	
ActualOvertimeCost


	
ResourceAssignment


	
Field


	



	



	






	
P6_RESOURCE_ASSGNMNT_ID


	
Labor


	
Field


	
ObjectID


	
ResourceAssignment


	
Field


	



	



	






	



	



	



	
UDF


	
ResourceAssignment


	
Group


	



	



	






	



	



	



	
TypeObjectID


	
UDF


	
Field


	



	



	






	
LABOR_SEQUENCE_NO


	
Labor


	
Field


	
TextValue


	
UDF


	
Field


	



	



	






	
Precedence


	



	
List


	
Relationship


	
Project


	
List


	



	



	






	
PLANT


	
Precedence


	
Field


	



	



	



	



	



	






	
PREDECESSOR_WORK_ORDER_TASK_NO


	
Precedence


	
Field


	



	



	



	



	



	






	
PREDECESSOR_WORK_ORDER_NO


	
Precedence


	
Field


	



	



	



	



	



	






	
SUCCESSOR_WORK_ORDER_TASK_NO


	
Precedence


	
Field


	



	



	



	



	



	






	
SUCCESSOR_WORK_ORDER_NO


	
Precedence


	
Field


	



	



	



	



	



	






	
PLANT


	
Precedence


	
Field


	



	



	



	



	



	






	
RELATIONSHIP_CODE


	
Precedence


	
Field


	
Type


	
Relationship


	
Field


	
WAMP6_Relationship


	
WAM_RelationshipCode


	
P6_RelationshipType





	
P6_PREDECESSOR_ACTIVITY_ID


	
Precedence


	
Field


	
PredecessorActivityObjectID


	
Relationship


	
Field


	



	



	






	
P6_SUCCESSOR_ACTIVITY_ID


	
Precedence


	
Field


	
SuccessorActivityObjectID


	
Relationship


	
Field


	



	



	






	
P6_RELATIONSHIP_ID


	
Precedence


	
Field


	
ObjectID


	
Relationship


	
Field


	



	



	






	



	



	



	
BusinessObjectOptions


	
CreateNewProject


	
Group


	



	



	






	



	



	



	
Global


	
BusinessObjectOptions


	
Group


	



	



	






	



	



	



	
Resource


	
Global


	
Group


	



	



	






	



	



	



	
ImportOption


	
Resource


	
Field


	



	



	






	



	



	



	
UDFType


	
Global


	
Group


	



	



	






	



	



	



	
ImportOption


	
Resource


	
Field


	



	



	











Update Project Response

Update Project Response Mapping details are similar to the Retrieve Project Details. For Update Project Response details, refer to Retrieve Project Details Response mapping details.





Retrieve Project Details

Contact Synchronization sync request and response mapping includes the following topics:




	
•


	
Retrieve Project Details Request











	
•


	
Retrieve Project Details Response












Retrieve Project Details Request

Retrieve Project Details Request mapping is as shown in the table below:




	
Oracle Utilities Work and Asset Management Message


	
Primavera P6 Enterprise Project Portfolio Management Message


	
DVM Mapping





	
Element Name


	
Parent Element


	
Type


	
 Element Name


	
Parent Element


	
Type


	
DVM


	
ODM


	
MDM





	
RetrieveProjectDetails


	



	
OutermostTag


	
ExportProject


	



	
OutermostTag


	



	



	






	



	



	



	
Encoding


	
ExportProject


	
Field


	



	



	






	



	
RetrieveProjectDetails


	
Field


	
FileType


	
ExportProject


	
Field


	



	



	






	



	
RetrieveProjectDetails


	
Field


	



	



	



	



	



	






	
ProjectObjectID


	
RetrieveProjectDetails


	
Field


	
ProjectObjectID


	
ExportProject


	
Field


	



	



	






	



	
RetrieveProjectDetails


	
Field


	
SpreadPeriodType


	
ExportProject


	
Field


	



	



	






	



	
RetrieveProjectDetails


	
Field


	
Spacing


	
ExportProject


	
Field


	



	



	











Retrieve Project Details Response

Details for Retrieve Project Details Response integration point are as shown in the table below:




	
Primavera P6 Enterprise Project Portfolio Management Response Message


	
Oracle Utilities Work and Asset Management Response Message


	
DVM Mapping





	
Element Name


	
Parent Element


	
Type


	
Element Name


	
Parent Element


	
Type


	
DVM


	
WAM Column


	
Primavera Column





	
ExportProjectResponse


	



	
OutermostTag


	



	



	



	



	



	






	
ProjectData


	
ExportProjectRespose


	
Field


	



	



	



	



	



	






	
APIBusinessObjects


	
ProjectData


	
Group


	



	



	



	



	



	






	
Project


	
APIBusinessObjects


	
Group


	
Project


	



	
OutermostTag


	



	



	






	



	



	



	
PLANT


	
Project


	
Field


	



	



	






	
ID


	
Project


	
Field


	
PROJECT_ID


	
Project


	
Field


	



	



	






	
Status


	
Project


	
Field


	
PROJECT_STATUS


	
Project


	
Field


	
WAMP6_ProjectStatus


	
WAM_ProjectStatus


	
P6_ProjectStatus





	



	



	



	
PROJECT_TITLE


	
Project


	
Field


	



	



	






	



	



	



	
PROJECT_SUPERVISOR


	
Project


	
Field


	



	



	






	
AnticipatedStartDate


	
Project


	
Field


	
ESTIMATED_START_DATE


	
Project


	
Field


	



	



	






	
AnticipatedFinishDate


	
Project


	
Field


	
ESTIMATED_COMPLETED_DATE


	
Project


	
Field


	



	



	






	
PlannedStartDate


	
Project


	
Field


	
ACTUAL_START_DATE


	
Project


	
Field


	



	



	






	
MustFinishByDate


	
Project


	
Field


	
ACTUAL_COMPLETE_DATE


	
Project


	
Field


	



	



	






	



	



	



	
LAST_UPDATE_DATE


	
Project


	
Field


	



	



	






	



	



	



	
LAST_UPDATE_USER


	
Project


	
Field


	



	



	






	



	



	



	
CREATE_DATE


	
Project


	
Field


	



	



	






	



	



	



	
CREATED_BY


	
Project


	
Field


	



	



	






	
UDF


	
Project


	
List


	



	



	



	



	



	






	
TypeObjectID


	
UDF


	
Field


	



	



	



	
WAMP6_ProjectUDF


	
WAM_ProjectUDFCode


	
P6_ProjectUDFTypeObjectID





	
TextValue


	
UDF


	
Field


	
ATTRIBUTE1


	
Project


	
Field


	



	



	






	
TextValue


	
UDF


	
Field


	
ATTRIBUTE2


	
Project


	
Field


	



	



	






	
TextValue


	
UDF


	
Field


	
ATTRIBUTE3


	
Project


	
Field


	



	



	






	
TextValue


	
UDF


	
Field


	
ATTRIBUTE4


	
Project


	
Field


	



	



	






	
TextValue


	
UDF


	
Field


	
ATTRIBUTE5


	
Project


	
Field


	



	



	






	
TextValue


	
UDF


	
Field


	
ATTRIBUTE6


	
Project


	
Field


	



	



	






	
TextValue


	
UDF


	
Field


	
ATTRIBUTE7


	
Project


	
Field


	



	



	






	
TextValue


	
UDF


	
Field


	
ATTRIBUTE8


	
Project


	
Field


	



	



	






	
TextValue


	
UDF


	
Field


	
ATTRIBUTE9


	
Project


	
Field


	



	



	






	
TextValue


	
UDF


	
Field


	
ATTRIBUTE10


	
Project


	
Field


	



	



	






	
DataDate


	
Project


	
Field


	
PROJECT_STATUS_DATE


	
Project


	
Field


	



	



	






	



	



	



	
PROJECT_MANAGER


	
Project


	
Field


	



	



	






	
OriginalBudgetAmount


	
Project


	
Field


	
PROJECT_LIMIT


	
Project


	
Field


	



	



	






	
ParentEPSObjectID


	
Project


	
Field


	
P6_EPS_NAME


	
Project


	
Field


	
WAMP6_EPS


	
WAM_EPSName


	
P6_EPSObjectID





	
Name


	
Project


	
Field


	
PROJECT_MANAGEMENT_TITLE


	
Project


	
Field


	



	



	






	
Description


	
Project


	
Field


	
DESCRIPTION


	
Project


	
Field


	



	



	






	
ObjectID


	
Project


	
Field


	
P6_ID


	
Project


	
Field


	



	



	






	
WBS


	
Project


	
List


	
Subproject


	
Project


	
List


	



	



	






	
Code


	
WBS


	
Field


	
SUBPROJECT_ID


	
Subproject


	
Field


	



	



	






	
STATUS


	
WBS


	
Field


	
SUBPROJECT_STATUS


	
Subproject


	
Field


	
WAMP6_SubprojectStatus


	
WAM_SubprojectStatus


	
P6_WBSStatus





	
Name


	
WBS


	
Field


	
SUBPROJECT_DESC


	
Subproject


	
Field


	



	



	






	
AnticipatedStartDate


	
WBS


	
Field


	
ESTIMATED_START_DATE


	
Subproject


	
Field


	



	



	






	
AnticipatedFinishedDate


	
WBS


	
Field


	
ESTIMATED_FINISH_DATE


	
Subproject


	
Field


	



	



	






	



	



	



	
ACTUAL_START_DATE


	
Subproject


	
Field


	



	



	






	



	



	



	
ACTUAL_COMPLETE_DATE


	
Subproject


	
Field


	



	



	






	



	



	



	
ACCOUNT_NO


	
Subproject


	
Field


	



	



	






	



	



	



	
PROJECT_TYPE


	
Subproject


	
Field


	



	



	






	



	



	



	
CREATED_BY


	
Subproject


	
Field


	



	



	






	



	



	



	
CREATE_DATE


	
Subproject


	
Field


	



	



	






	



	



	



	
LAST_UPDATE_USER


	
Subproject


	
Field


	



	



	






	



	



	



	
LAST_UPDATE_DATE


	
Subproject


	
Field


	



	



	






	



	



	



	
SUPERVISOR_NAME


	
Subproject


	
Field


	



	



	






	



	



	



	



	
Subproject


	
Field


	



	



	






	



	



	



	



	
Subproject


	
Field


	



	



	






	
OriginalBudget


	
WBS


	
Field


	
BUGET_AMOUNT


	
Subproject


	
Field


	



	



	






	
UDF


	
WBS


	
List


	



	



	



	



	



	






	
TypeObjectID


	
UDF


	
Field


	



	



	



	
WAMP6_SubprojectUDF


	
WAM_SubprojectUDFCode


	
P6_WBSUDFTypeObjectID





	
TextValue


	
UDF


	
Field


	
ATTRIBUTE1


	
Subproject


	
Field


	



	



	






	



	



	



	
ATTRIBUTE2


	
Subproject


	
Field


	



	



	






	



	



	



	
ATTRIBUTE3


	
Subproject


	
Field


	



	



	






	



	



	



	
ATTRIBUTE4


	
Subproject


	
Field


	



	



	






	



	



	



	
ATTRIBUTE5


	
Subproject


	
Field


	



	



	






	



	



	



	
ATTRIBUTE6


	
Subproject


	
Field


	



	



	






	



	



	



	
ATTRIBUTE7


	
Subproject


	
Field


	



	



	






	



	



	



	
ATTRIBUTE8


	
Subproject


	
Field


	



	



	






	



	



	



	
ATTRIBUTE9


	
Subproject


	
Field


	



	



	






	



	



	



	
ATTRIBUTE10


	
Subproject


	
Field


	



	



	






	



	



	



	
REQUESTOR


	
Subproject


	
Field


	



	



	






	



	



	



	
REQUESTDATE


	
Subproject


	
Field


	



	



	






	



	



	



	
REQUESTOR_DEPARTMENT


	
Subproject


	
Field


	



	



	






	



	



	



	
REQUESTOR_PHONE_NO


	
Subproject


	
Field


	



	



	






	



	



	



	
REQUIRED_DATE


	
Subproject


	
Field


	



	



	






	
ObjectID


	
WBS


	
Field


	
P6_WBS_ID


	
Subproject


	
Field


	



	



	






	
WBS


	
Project


	
List


	
WorkOrder


	
Subproject


	
List


	



	



	






	
ParentObjectID


	
WBS


	
Field


	



	



	



	



	



	






	
Code


	
WBS


	
Field


	
WORK_ORDER_NO


	
WorkOrder


	
Field


	



	



	






	



	



	



	
WORK_TYPE


	
WorkOrder


	
Field


	



	



	






	
Name


	
WBS


	
Field


	
WORK_DESC


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ACCOUNT_NO


	
WorkOrder


	
Field


	



	



	






	
Status


	
WBS


	
Field


	
WORK_STATUS


	
WorkOrder


	
Field


	



	



	






	



	



	



	
WORK_STATUS_DATE


	
WorkOrder


	
Field


	



	



	






	



	



	



	
WORK_CLASS


	
WorkOrder


	
Field


	



	



	






	



	



	



	
WORK_CATEGORY


	
WorkOrder


	
Field


	



	



	






	



	



	



	
REQUESTOR_NAME


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ASSET_RECORD_TYPE


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ASSET_ID


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ASSET_DESC


	
WorkOrder


	
Field


	



	



	






	



	



	



	
COMPONENT_ID


	
WorkOrder


	
Field


	



	



	






	



	



	



	
COMPONENT_ID_DESC


	
WorkOrder


	
Field


	



	



	






	



	



	



	
PROCESS_NO


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ACCOUNT_NO


	
WorkOrder


	
Field


	



	



	






	



	



	



	
TASK_PRIORITY_DEFAULT


	
WorkOrder


	
Field


	



	



	






	



	



	



	
PLANNER


	
WorkOrder


	
Field


	



	



	






	



	



	



	
LEAD_CREW


	
WorkOrder


	
Field


	



	



	






	



	



	



	
DEFICIENCY_TAG


	
WorkOrder


	
Field


	



	



	






	
OriginalBudget


	
WBS


	
Field


	
PLANNED_TOTAL_AMOUNT


	
WorkOrder


	
Field


	



	



	






	
CurrentBudget


	
WBS


	
Field


	
APPROVED_AMOUNT


	
WorkOrder


	
Field


	



	



	






	



	



	



	
INSPECTION_IND


	
WorkOrder


	
Field


	



	



	






	



	



	



	
CLOSED_WO_IND


	
WorkOrder


	
Field


	



	



	






	
UDF


	
WBS


	
List


	



	
WorkOrder


	
Field


	



	



	






	
TypeObjectID


	
UDF


	
Field


	



	



	



	
WAMP6_WORKORDER_UDF


	
WAM_WORKORDER_UDFCODE


	
P6_WBSUDFTypeObjectID





	
TextValue


	
UDF


	
Field


	
ATTRIBUTE1


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ATTRIBUTE2


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ATTRIBUTE3


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ATTRIBUTE4


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ATTRIBUTE5


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ATTRIBUTE6


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ATTRIBUTE7


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ATTRIBUTE8


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ATTRIBUTE9


	
WorkOrder


	
Field


	



	



	






	



	



	



	
ATTRIBUTE10


	
WorkOrder


	
Field


	



	



	






	
ObjectID


	
WBS


	
Field


	
P6_WBS_ID


	
WorkOrder


	
Field


	



	



	






	
Activity


	
Project


	
List


	
WorkOrderTask


	
WorkOrder


	
List


	



	



	






	
ID


	
Activity


	
Field


	
WORK_ORDER_TASK_NO


	
WorkOrderTask


	
Field


	



	



	






	
WBSObjectID


	
Activity


	
Field


	



	



	



	



	



	






	
ProjectID


	
Activity


	
Field


	



	



	



	



	



	






	



	



	



	
TASK_SEQUENCE_NUMBER


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
TASK_STATUS


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
TASK_STATUS_DATE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
TASK_DESC


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
WORK_CLASS


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
WORK_CATEGORY


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ASSET_RECORD_TYPE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ASSET_ID


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ASSET_DESC


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
COMPONENT_ID


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
COMPONENT_ID_DESC


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
PROCESS_NO


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
PLANNER


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
DEPARTMENT


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
AREA


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ACCOUNT_NO


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
VEHICLE_SYSTEM_CODE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
VEHICLE_ASSEMBLY_CODE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
VEHICLE_COMPONENT_CODE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
SAFETY_CRITICAL_IND


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ISO_IND


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
HEALTH_IND


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ENVIRONMENTAL_IND


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
RUN_TO_FAILURE_IND


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
TASK_PHASE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
HELD_FOR_PARTS_IND


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
TASK_REQUIRED_DATE


	
WorkOrderTask


	
Field


	



	



	






	
PhysicalPercentComplete


	
Activity


	
Field


	
PERCENT_COMPLETE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
DOWNTIME_IND


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
DOWNTIME_TYPE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
DOWNTIME_HOURS


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
TASK_PRIORITY_TOTAL


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
CRITICALITY


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
TASK_PRIORITY


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
TASK_PRIORITY_ADJUSTMENT


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
CREW


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
BACKLOG_GROUP


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
SHOP


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
PM_ROUTE_NO


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
SCHEDULE_DATE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ASSIGNED_TO_NAME


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
WORK_LOCATION


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
TRAVEL_TIME


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
WORK_TRIP


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
JOB_CODE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
JOB_REASON_CODE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
JOB_ACTION_CODE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
METER_READING_DATE


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
METER_READING_CURRENT


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
METER_UNITS


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
METER_LTD


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
REPORT_CODE1


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
REPORT_CODE2


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
REPORT_CODE3


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
REPORT_CODE4


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
REPORT_CODE5


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
WORK_REQUEST_NO


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
SERVICE_REQUEST_NO


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
DEFICIENCY_TAG


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
WBS


	
WorkOrderTask


	
Field


	



	



	






	
PlannedDuration


	
Activity


	
Field


	
ESTIMATED_DURATION


	
WorkOrderTask


	
Field


	



	



	






	
PlannedStartDate


	
Activity


	
Field


	
TASK_ESTIMATED_START_DATE


	
WorkOrderTask


	
Field


	



	



	






	
PlannedFinishDate


	
Activity


	
Field


	
TASK_ESTIMATED_FINISH_DATE


	
WorkOrderTask


	
Field


	



	



	






	
ActualDuration


	
Activity


	
Field


	
ACTUAL_DURATION


	
WorkOrderTask


	
Field


	



	



	






	
ActualStartDate


	
Activity


	
Field


	
ACTUAL_START_DATE


	
WorkOrderTask


	
Field


	



	



	






	
ActualFinishDate


	
Activity


	
Field


	
ACTUAL_FINISH_DATE


	
WorkOrderTask


	
Field


	



	



	






	
UDF


	
Activity


	
List


	



	



	



	



	



	






	
TypeObjectID


	
UDF


	
Field


	



	



	



	
WAMP6_WorkOrderTaskUDF


	
WAM_WorkOrderTaskUDFCode


	
P6_ActivityUDFTypeObjectID





	
TextValule


	
UDF


	
Field


	
ATTRIBUTE1


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ATTRIBUTE2


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ATTRIBUTE3


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ATTRIBUTE4


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ATTRIBUTE5


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ATTRIBUTE6


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ATTRIBUTE7


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ATTRIBUTE8


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ATTRIBUTE9


	
WorkOrderTask


	
Field


	



	



	






	



	



	



	
ATTRIBUTE10


	
WorkOrderTask


	
Field


	



	



	






	
ObjectID


	
Activity


	
Field


	
P6_ACTIVITY_ID


	
WorkOrderTask


	
Field


	



	



	






	
ResourceAssignment


	
Project


	
List


	
Labor


	
WorkOrderTask


	
Field


	



	



	






	
ResourceObjectID


	
ResourceAssignment


	
Field


	



	



	



	



	



	






	



	



	



	
CRAFT


	
Labor


	
Field


	



	



	






	
PlannedUnitsPerTime


	
ResourceAssignment


	
Field


	
CRAFTSMEN_QUANTITY


	
Labor


	
Field


	



	



	






	



	



	



	
LABOR_DURATION


	
Labor


	
Field


	



	



	






	



	



	



	
EXPENSE_CODE


	
Labor


	
Field


	



	



	






	



	



	



	
PREMIUM_EXPENSE_CODE


	
Labor


	
Field


	



	



	






	
PlannedUnits


	
ResourceAssignment


	
Field


	
ORIGINAL_ESTIMATE_HOURS


	
Labor


	
Field


	



	



	






	
PlannedCost


	
ResourceAssignment


	
Field


	
ORIGINAL_ESTIMATE_AMOUNT




	
Labor


	
Field


	



	



	






	
ActualThisPeriodUnits


	
ResourceAssignment


	
Field


	
REVISED_ESTIMATE_HOURS


	
Labor


	
Field


	



	



	






	
ActualThisPeriodCost




	
ResourceAssignment


	
Field


	
REVISED_ESTIMATE_AMOUNT


	
Labor


	
Field


	



	



	






	



	



	



	
EXTERNAL_COMMITTED_HOURS


	
Labor


	
Field


	



	



	






	



	



	



	
EXTERNAL_COMMITTED_AMOUNT


	
Labor


	
Field


	



	



	






	
ActualRegularUnits


	
ResourceAssignment


	
Field


	
ACTUAL_HOURS


	
Labor


	
Field


	



	



	






	
ActualRegularUnits


	
ResourceAssignment


	
Field


	
ACTUAL_AMOUNT


	
Labor


	
Field


	



	



	






	
ActualOvertimeUnits


	
ResourceAssignment


	
Field


	
ACTUAL_PREMIUM_HOURS


	
Labor


	
Field


	



	



	






	
ActualOvertimeCost


	
ResourceAssignment


	
Field


	
ACTUAL_PREMIUM_AMOUNT


	
Labor


	
Field


	



	



	






	
ObjectID


	
ResourceAssignment


	
Field


	
P6_RESOURCE_ASSIGNMENT_ID


	
Labor


	
Field


	



	



	






	
UDF


	
ResourceAssignment


	
Group


	



	



	



	



	



	






	
TypeObjectID


	
UDF


	
Field


	



	



	



	



	



	






	
TextValue


	
UDF


	
Field


	
LABOR_SEQUENCE_NO


	
Labor


	
Field


	



	



	






	
Relationship


	
Project


	
List


	
Precedence


	



	
List


	



	



	






	
Type


	
Relationship


	
Field


	
RELATIONSHIP_CODE


	
Precedence


	
Field


	
WAMP6_Relationship


	
WAM_Relationship


	
P6_RelationshipType





	
PredecessorActivityObjectID


	
Relationship


	
Field


	
P6_PREDECESSOR_ACTIVITY_ID


	
Precedence


	
Field


	



	



	






	
SuccessorActivityObjectID


	
Relationship


	
Field


	
P6_SUCCESSOR_ACTIVITY_ID


	
Precedence


	
Field


	



	



	






	
ObjectID


	
Relationship


	
Field


	
P6_RELATIONSHIP_ID


	
Precedence


	
Field


	



	



	






	



	



	



	
ErrorInformation


	
Project


	
Group


	



	



	






	



	



	



	
ErrorCode


	
ErrorInformation


	
Field


	



	



	






	



	



	



	
ErrorDescription


	
ErrorInformation


	
Field


	



	



	











Appendix A - Data Mapping





7 Retrieving Object IDs from Web Services

The Object IDs created in Primavera P6 Enterprise Project Portfolio Management are not displayed in the system. The Object IDs can be retrieved from the Primavera P6 Enterprise Project Portfolio Management database if users have access. Another way of retrieving the Object ID is by using web services which are part of the Primavera P6 Enterprise Project Portfolio Management installation.

The list of web services is accessible at URL:

http://<primaveraHost>:<primaveraPort>/p6ws/services along with endpoints and WSDL address.

Implementers can use tools like JDeveloper, Eclipse, or SoapUI to invoke the web services and retrieve the Object IDs from Primavera P6 Enterprise Project Portfolio Management.

The Object IDs required for this Integration are as listed below:





EPS ObjectID




	
•


	
Service Name - EPSService











	
•


	
Operation Name - ReadEPS











	
•


	
Sample Request











	



	
 <ReadEPS>











	



	
 <Field>Id</Field>











	



	
 <Field>ObjectId</Field>











	



	
 </ReadEPS>











	
•


	
Response











	



	
The response returns a list of all Enterprise Project Structure (EPS) in the Primavera P6 Enterprise Project Portfolio Management system with ID and ObjectID.












UDFType ObjectID




	
•


	
Service Name - UDFTypeService











	
•


	
Operation Name - ReadUDFTypes











	
•


	
Sample Request











	



	
<ReadUDFTypes>











	



	
 <Field>Title</Field>











	



	
 <Field>SubjectArea</Field>











	



	
 <Field>DataType</Field>











	



	
 <Field>ObjectId</Field>











	



	
</ReadUDFTypes>











	
•


	
Response











	



	
The response returns a list of all UDFTypes in the Primavera P6 Enterprise Project Portfolio Management system with Title, SubjectArea, DataType, and ObjectID.












Project ObjectID




	
•


	
Service Name - ProjectService











	
•


	
Operation Name - ReadProjects











	
•


	
Sample Request











	



	
<ReadProjects>











	



	
 <Field>Id</Field>











	



	
 <Field>Name</Field>











	



	
 <Field>ObjectId</Field>











	



	
</ReadProjects>











	
•


	
Response











	



	
The response returns a list of all projects in the Primavera P6 Enterprise Project Portfolio Management system with ID, Name, and Object ID.
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1 Preface

Audience

This document is intended for anyone implementing Oracle Utilities Work and Asset Management (WAM) Integration to Primavera P6 Enterprise Project Portfolio Management.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit: http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info

or

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.





Part 1

Understanding the Integration

This section provides an overview of the participating applications and information regarding the business processes addressed by this integration.

This section contains the following chapters:




	
•


	
Overview











	
•


	
Understanding the Integration Process










Part 1 - Understanding the Integration





Part 2

Implementing the Integration Product

This section provides details on how to configure the participating applications and middleware layer for this AIA direct integration. It also includes information on error handling, monitoring, customization options, and data mapping.

This section contains the following chapters:




	
•


	
Configuring the Integration











	
•


	
Monitoring and Troubleshooting











	
•


	
Customization Options
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